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Getting Started

Installation

After downloading the Sellerdeck Desktop installer, double-click the
downloaded file to run the Installation Wizard that will guide you
through the set-up process.

It is possible to achieve a perfectly satisfactory installation by accepting
all the default settings suggested to you. Click 'Next' to take you from
screen to screen, click 'Back' to take you to the previous screen and click
'Cancel' to abort the installation process.
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Starting Sellerdeck Desktop

Sellerdeck Desktop is designed to publish an online store onto the
internet, and then receive and process orders from that store.

It works by taking all your product data and turning it into a set of web
pages, based on the design options you have selected. It then also
manages all the functionality to control the shopping cart, search and
online security at your online store.

When you first start Sellerdeck Desktop, you will see the following
screen:

software Authorization Key

Y'ou can enter an authorization key now, or evaluate the software witho
Authaorization

SellerDeck requires an autharization key. Thiz key can be found inside
purchased fram wour vendar,

Please enter pour authaorization key in the form aaa-aaa-aaa-aaa |

E valuation

Chooze the version of SellerDeck you wizh to evaluate, up to a masim
ol wizh chooze a different version each time pou start the zoftware.

Please Hote: The SellerDieck Enterprise 30 day evaluation will install L
databaze. e recommend vou contact SellerDeck Sales on 08345 128
to dizcuss vour project and SellerDeck Enterprize SCL.

Ewvaluation Yersion : g siness -

If you have a license key for Sellerdeck Desktop, enter it in the field
provided and click 'Authorise'.

If you are setting up a multi-user site with Business Plus, you will also
need to enter a username of Administrator and a password of
Administrator.

If you want to evaluate Sellerdeck Desktop then you need to select one of
the product options at the bottom half of the window - either Sellerdeck
Business or Sellerdeck Enterprise.

You will then see the following screen:
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.
Business Plus - New_Site: Online Catalogue

File Edit Settings Design Operations Marketing Web Housekeeping Window Help

9% :.'1 EE @ = @ ' ﬁBusiness Settings E{; Site Options LE] - Qfg Retrieve Orders 30 &JRepor‘t; ) @ | Q ]
E 10 Preview Store é)Puin;h toWeb |9
g Cortent ||Z Design ICB Orders I ok New Orderl

Content Tree ) |§\| Start Here
= N~ e
ﬁ Home

E‘ More Pages
B‘Q Online Catalogue
j--- Rings
o[
j--- Bracelets
j--- Earrings
Wedding Jewellery
.[iF] Mens
Best Sellers

Mew Products
~-{#l Multi Pearl Bracelet
@ Amethyst Heart Mecklace

Start Editi ng
Store Contents

3
&

Company Tax
Details Rates Methods

The Start Here Panel

In the main part of the screen is the 'Start Here' panel. This is designed to
take you through the most important areas of the software.

Click on one of the buttons and it will open up to show more
information:

If you are a new business, you probably aren't going to be al
numbers online and process them yourself. The banks just
there are companies called ‘Payment Service Providers' who

At the bottom of each page of the Start Here panel are some links to some
useful chapters in the main Sellerdeck Desktop help.

Getting Started Guide

Getting Started o 7



O help

How do | take credit cards onl

How do | integrate Actinic wit

=y [=SENTT-N

Also, while looking through the Start Here panels you will see some links
that will take you straight to that related area of Sellerdeck Desktop.

Edit your setting?

Also, if you click on the link that says 'Change the look and feel of the
store', you will see a button to start the 'Design Wizard'.

The Design Wizard will help you customise the structure and g
pages. First you need to choose a look and feel and a colour §

SellerDeck includes a range of built in Themes' that provide a variety
which can be recoloured using any of the built in Colour Schemes.

Applying a theme will reset the Site-level selections for all main layo
theme.

Click to choose your Theme and Colour Scheme I

Thermes Y e

T e

Classin Fosponsive
Pl piwivaiv s Wi it

The Design Wizard is a quick way to apply a basic design to your store
where you can set the layout and colours for the design. Give it a try to
see what happens. If you don't like the basic theme it gives you, there are
some others to choose from in 'Design | Themes'.

Checking Out The Example Store

Down the left hand side of the program is the 'Content Tree'. This shows
you the section, products, pages and information items in your store.
Click on the '+'icons in the tree to expand a branch of the tree.

EI@ Online Catalogue

E| Mecklaces
: |:_| Lockets
----- @- Picture F

@ Golden H

Click on any item in the tree to see its details appear in the 'Details' panel
to the right.

LI Apply changes Cancel cha

= I - ~

You can also click on the Page Preview' panel to see how the item you
have clicked on will look in your online store.

8 e Getting Started
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Other Places To Look

There are two other main tabs along the top of the Sellerdeck Desktop

screen:

| = Content [ [ Design | @ Orders| |

The 'Design' tab is where you can change the look and feel of
your store pages. There are details of this in "The Design
Tab" on page 84.

The 'Orders' tab is where you manage and process the orders
received at the store. More details on this are in "Processing
An Order" on page 63.

Exercise - Personalising Your Store Design

This exercise will show you how to give the default Sellerdeck Desktop
store your own personal stamp.

To begin with, you are going to run the Design Wizard to customise a
quick new look and feel for the store.

1.

Click on the Page Preview tab at the bottom of the Content
tab. This shows what the store looks like at the moment. You
can get this look and feel back at any time by re-selecting the
default 'theme' (called 'Elegance'). This is talked about later
in "Choosing A Theme" on page 76.

Look at the Start Here panel and click on the 'Design Wizard'
button:

On the first page, you can open the Design Themes dialog to
choose an overall look and feel and a colour scheme.

NB if you are upgrading from an earlier version, you should
first click the ‘Reset Layout Defaults” button to switch your
site to the latest theme layouts. You can also use this button
at any time to reset your top-level layouts to the defaults.

Afrter picking a theme click 'OK' and then click 'Next >' to
continue.

After clicking 'Next >' you can switch to the Page Preview
tab to see the efffect of your pages. You can do this from any
page of the Design Wizard.

On the next page you can choose whether to have two
sidebars in your site, or just a left sidebar. If you choose only
a left sidebar, take care not to allocate anything to the right
sidebar later in the wizard. Click 'Next >' to continue.

Getting Started Guide
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& Design Wizard

Do you want your site to have one or two sidebars?

NB: if you choose to have only a Left Sidebar, do not place any ¢
later in the wizard.

6. In the next few screens you can choose where Sellerdeck
Desktop will place things like quick search bars, menus and
best sellers lists. You can re-run the wizard if you are not
happy with your choices.

7. Eventually you will get to the final screen where there will be
a 'Finish' button.

Fnit >
8. Click this button and then go to the Page Preview panel to
see your new design.

If you don't like what you see, re-run the Design Wizard or go to
'Design | Themes' to choose an alternative look and feel for your store.

Next you are going to select a new 'Corporate Logo' image to go at top of
every store page.

1. Go to 'Design | Themes'

2. At the bottom of the window, under where it says 'Corporate
Logo' click the 'Browse' button and select a new image from
your PC.

Corporate Logo

| my-new-image. gif

This might be an image you use in letterheads, or one you
use on an existing website. It needs to be a '*.gif' file or a
*jpg' file and not be too enormous (i.e. not more than about
600 pixels wide).

3. Once you've selected an image, click 'OK' to use it in
Sellerdeck Desktop.

4. Check the Page Preview panel to see how your new logo
looks.

10 ¢ Getting Started Getting Started Guide



More Information - Getting Help With Sellerdeck
Desktop

Whenever you are looking at a new area in Sellerdeck Desktop, look out
for the 'How Do I' buttons.

& How Da I?

Click these buttons to bring up a help file with link to lots of relevant step
by step guides to using Sellerdeck Desktop.

o —

% ActinicMainHelp

T ¢ & 0

Hide Back  Print thions

Cortents Igdexl Search

Product Options

SO G e = Creating Product
C cting Muttiple U [ :
g g Pfon;;ﬂ;ng PSS The '"Product Options' panel o
= ([ Product Cptions options to your products.
Create Options
Differert Types of Choices, Attributes ani
Basic Options Add a Mew Option....

What Are Components?

upplying Additional tems With A Produg
Component Pricing Madel
Making Customer Selection Affect Price
Changing the Layout of Components E dit Options

&3] @ Sections

=] @ Brochure Pages & Fragments

= @ Business Settings G i R b ;
i ; nce yaur options have been createc
= @ Shipping and Handling Click. thiz buttan to show all the optior

= @ Taking Paymert product.
=] @ Discounts 1T
=] @ Marketing Your Products

If pou want to offer your products in a
ar sizes then yau can achisve this by
Click this button to start creating these

m

Expand All Current Options

You can access the entire Sellerdeck Desktop help file by going to the
'Help' menu and selecting 'Help Topics'. Or you can click the & button on
the toolbar. When viewing the help, use the 'Contents' tab of the help to
browse by topic. Alternatively, use the 'Index' or the 'Search' to locate key
words or phrases.

In addition, click on the question mark - @ - at the top right of the Details
panel (or any of the windows within Sellerdeck Desktop) and then click
in a field. You will be shown a little piece of help about the field.

Ec' iyl

Chick this button b
exacty how pou ar

Getting Started Guide
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Previewing

Each separate section (and each brochure page) in the store will
eventually become a single web page in your online store.

The Page Preview panel shows you what the page you have selected in
the content tree will look like online. If you are finding the panel too
small, or you would like experience more of how your customers will see
the site, you can always do an offline preview. This allows you to check

out your store design in a web browser.

There are two ways to preview

o Preview Current Page - Opens only the current page in a

web browser. To do this, click the 21 button on the toolbar,
go to 'Web | Preview Current Page' or press [Ctr]l + A] on

your keyboard.

e Preview Store - Previews all the brochure pages and section
pages in your store, showing you how it all fits together. To
do this, click the o button on the toolbar, go to 'Web |
Preview Store' or press [Ctrl + W] on your keyboard.

Exercise - Previewing

This exercise will step you through the two different kinds of
previewing.

1. Make sure you are on the Content tab.

2. Click on any section (or brochure page) in the store and click

the 2] button on the toolbar.

3. This will display your page in your normal web browser.

[ Lockets x

Smart

Home

Lockets

More Pages

Best Sellers 5 "’~%‘*~} Picture Frame Locket
otd A

4. Now go back to Sellerdeck Desktop and click the @ button

on the toolbar.

5. Navigate through the sections in your store (using the links

provided) to view them.

12 o Getting Started
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6. Try adding something to the shopping cart. You should get a
warning message. This is because you cannot test store
functionality with a preview - only the look and feel.

Exercise - Previewing Other Pages

This exercise will show you how to preview pages that are not in your
content tree.

1. Go to the Design tab (not available in Client versions).

2. Locate the 'Select Page Type' drop down, which is above the
preview panel on this tab.

er I e Senrices!

Select Page Type Content Page E Click here to see errors
Site Map -]
Terms And Conditions
Contact Us

Search

Search Results

Login

Signature

Add To Cart Confirmation
Shopping Cart

Checkout Page
Checkout Pagel
Checkout Page 2 54

3. Select a page other than 'Content Page'. The page you select
will appear in the preview panel.

m

4. You can then click the £ button to see how this page will
look in a web browser.

If you are previewing a shopping cart or checkout page within a preview
page, it will contain some example data.

More Information - The Design Tab

The preview panel on the Design tab is different from the one on the
Content tab as it is interactive. You can click on something in the
preview, and the HTML code for that item will appear in the 'Layout
Code' panel within the tab.

For more information about using the Design tab, please see the chapter
called "The Design Tab" on page 84.

Getting Started Guide
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Products

The whole of Sellerdeck Desktop is effectively geared around the
presentation and promotion of your products. Consequently there are
many options within Sellerdeck Desktop that change how your products
look and work. With Sellerdeck Desktop you can (among other things):

e Enter a stock level for a product.

o Create an extended information window, containing a larger
image and/or a longer description.

o  Set whether the product price is shown including or excluding
tax.

e Set whether a downloadable file will be available to customers
who buy a product.

e Setup alist of related items that will appear underneath a
product.

¢ and many more...
Within the content tree products look like this: 0

If there is a '+' next to the product, it is because that product contains
options such as 'size' or 'colour’ etc.

Try clicking on some of the example products that are in Sellerdeck
Desktop, and look at the panels in the Details panel to see the sort of
things you can configure on a product.

Don't forget you can get information about a setting by clicking on the @
at the right of the Details panel title bar and then clicking in a setting.

Exercise - Adding a New Product
1. Right-click on the 'Necklaces' section in the content tree.

2. On the right-click menu, select 'New Product'.

5@ Online Catalogue
[+ |__='|

Copy

Publish Current Page

Offline Page Preview

Mew Fragment

Mew Section

Mew Sub-Section

:
_____ i
..... i
..... B
_____ i

fi

Mew Product

Tk

3. Make sure you are looking at the 'General' panel by selecting
'General' in the list of panels to the left of the 'Details' panel.

4. In the 'Short Description' field, enter 'Golden Heart
Necklace'.

14 o Getting Started
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5. In the 'Price' field, enter '85.00'.

6. In the 'Full Description' field enter 'A beautiful gold necklace
for you or your loved one'.

7. Inthe 'Image' field click 'Browse'. You need to be in the 'Sitel'
folder. If you are not there, browse to the '...\Sites\Sitel'
folder on your PC.

8. Select's-Golden-Heart-Locket-Open.jpg' from the 'Sitel'
folder.

Reference: 4

Short Descrption:  Golden Heart Mecklace

Price: £85.00 Use Prices Tab
Full T egcription;

A, beautiful emerald necklace for wou or your loved one

9. Switch to the 'Layout' panel and check that the Price Layout'
is 'Standard Tax Inclusive Price'. This will mean that the
price for this product will be displayed including tax.

10. Click the 'Apply Changes' button.

Your new product will appear in the content tree and also in the preview
panel.

By default, each product is given its own page on the web site. This is
generally the recommended configuration. If you only want to display
products in a list layout, you can disable their product pages in the
'Product Page' panel. If you do not want product pages to be generated
by default, you can change the appropriate setting in the 'Miscellaneous
Options' (Settings | Business Settings | Options). In this case you can still
enable product pages individually for specific products.

Exercise - Formatting Text

This exercise will show you how to change the appearance of the text in
your product description.

1. Highlight the word 'beautiful' within the 'Full Description'
field of your new product.

2. Press the B button on the toolbar at the top of the details
panel.

3. Click 'Apply Changes'.

4. This will make the word 'beautiful' appear bold in the
preview.

Feel free to experiment with the other text formatting options on the
toolbar to see what effect they have.

Getting Started Guide Getting Started ¢ 15



Exercise - Extended Information Windows

This exercise will add an extended information window to your new
'Golden Heart Necklace' product.

1. Switch to the 'Extended Information' panel.

2. Select 'Generate Pop Up Page'.

3. Inthe 'Image' field, select ' s-Golden-Heart-Locket-Open.jpg'.
4

In the 'Text' field enter 'This is a longer description for the
gold necklace'.

Click the 'Links' tab.

6. Under 'Links from Product List, click 'Displays the Extended
Information Page' against 'Clicking the Product Image'.

o

7. Under 'Links from Product Page', tick 'Product Image Link to
Extended Information Page'.

8. Click 'Apply Changes'.

This change has created an additional 'extended information' page that
will be opened in a pop-up window when you click the product image.

In order to see the effect this change has made, you will need to:

9. Do a store preview by clicking the " button on the toolbar.

10. Then browse to your golden heart necklace product, which is
currently in the 'Necklaces' section.

11. When you get there, click the 'More Info...' link.

& Sample Company Golden Heart Necklace - Go

|7 file/ 7/ C:/ProgramData/SellerDeck3a202013/Ne
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More Information - Other Product Settings

If you want to ask a general question when people buy this product, then
enter the question within the 'Other Info' field on the 'Prompts' panel.
You can also add a date-related question here such as 'When would you
like the flowers delivered?'.

What name swould you like on the gift

Use the 'Product Layout' field in the 'Layout' panel to try alternative
layouts for this product. If you want a more compact layout, try the 'No
Image No Description Laid Out In Single Line' layout. Feel free to
experiment with the different layouts there to see the effect they have.
Change it back to 'Use Parent' if you want to put it back to the way it
was.

There is more information on choosing layouts in "Choosing Alternative
Layouts" on page 81.

It is also possible to import a whole load of products in one go from a
spreadsheet with an import. This is described in the main help in the
section called 'Importing’'.

Getting Started Guide
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Sections

You can use sections to organise your products into separate pages - a
section becomes a web page in the online store. You can create sections
within other sections to create a store hierarchy - and Sellerdeck Desktop
will automatically create a link from one section to another.

Exercise - Adding a New Section

This exercise will add a new section to the store, and show you how to
move a product into it.

1. Right-click on the 'Necklaces' section and select 'New
Section'.

£ Online Catalogue

3 Rings

[ Bral Copy

[:5] Ean Paste

& we

[ Me Publish Current Page

[ Bes Offline Page Preview
LEEN
M? MNew Fragment

@ Arm Mew Section

Note: If you select New Sub-Section', it creates the section within the
current section.

2. Enter a name of 'Gold Chains' and a description of 'An
attractive range of gold chains'.

3. Click 'Apply Changes'.

Mame:  Gold Chainz
Image:
Dezcription:

An attractive range of gold chains.

Your new section has been created in the content tree. The description
will be used in the link to the section, which will appear on the store
front page (you can view this page by clicking on the green 'Online
Catalog' icon in the content tree).

You are now going to drag and drop your 'Gold Chain' product into the
new "Gold Chain' section.

4. In the content tree click on the 'Gold Chain' product and hold
the mouse button down.

18 o Getting Started
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Keeping the mouse button held down, drag the mouse
cursor into the 'Gold Chains' section.

Release the mouse button. The 'Gold Chain' product should
now be in the 'Gold Chains' section.

Exercise - Optimising A Section

This section will show you how to use the 'Shopping Mode' feature -
which controls how products in a section behave when they are added to
the shopping cart.

You will also see a few search-engine optimisation features.

1.

3.
4.

Go to your 'Gold Chains' section and go to the Page Settings'
panel.

Change the Page Name' field to 'best-quality-gold-
chains.html' (all lower case).

In the 'Page Title' field enter 'Best Quality Gold Chains'.
Click 'Apply Changes'.

Changes like this can help your page to be more visible to search engines.

The next change will remove the 'Quantity’ field from the HTML page.

5.

Under 'Shopping Mode' (on this panel) de-select the 'Use
Parent Settings' checkbox and select 'Quantity in Shopping
Cart'.

Click 'Apply Changes'.

Page Title: Buy Digital Photo Frames For our Digital Photos

Shopping Mode

[T Use Parent Settings 1 Quantity on Product Page Sir|

Online customers will now enter the quantity of products they require
once they have added product to the shopping cart.

Getting Started Guide
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Product Options

There are many different ways to add options to a product. Here are
some examples of things you can do in Sellerdeck Desktop:

A simple range of colour options.

A range of colour options where each colour is individually
stock monitored.

A range of size and colour options.
An extra add-on that costs extra.

A range of options where each choice costs a different
amount.

Options in the content tree look like this:

[ H
Attributes - Bzl - These are characteristics of a product that
can vary such as 'style', 'length’, 'size', etc.

Choices - 123 - These are individual options within an
attribute.

Components - - These allow you to create more
sophisticated options such as an optional extra (that costs
money) or a range of options where each option is a different
price.

You can create options using the Product Options' panel of a product.

Exercise - Creating Simple Choices

This exercise will allow you to create a range of simple options for the

Gold Chain.
1.

Click on the Gold Chain product and select the Product
Options' panel.

Create Options

Add a Mew Option....

[f you want to offer your products in a range of differs
or gizes then you can achieve thiz by creating ‘Attnb
Click. thiz button to start creating these.

Edit Optionz

Fenand Al Current Onbinn

2. Click the 'Add a New Option...' button to start the 'Add a

New Options' wizard.

20 e Getting Started
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Add a New Option

Enter a name for your option fe.g. “Size” or Tolor’) and then enter some
choices in the grid. This option is known as an 'Attibute” and looks like
thig in the content tree:

Name of Option:

+|| Choices for

b= || To add rows, click tl

If you want different combinations of options to be . |comer ik

priced differently e.g. a customer will pay a certain
amount when they select a certain size with a =
certain color) then select this box: =

3. Inthe'Name of Option' field, enter 'Length'.

4. In the 'Choices for Length' grid, click the '+' button (at the top
left) three times to create three blank rows.

5 Choices for Size

¥lriv|v ¥

5. (lick in the first row and enter '40cm’'.

6. Inthe rows under that enter '45cm ', '50cm '. You can use the
'down' arrow on your keyboard to move to the next row
quickly.

7. When you have entered your choices, click 'Next'.

8. Just click 'Next>' again twice (as you are not setting prices,
stock levels or layouts) and then click 'Finish' to create your
options.

Your new options will be visible in the content tree. You might need to
click the 'Expand All Current Options' button to see all the options.

=123 Gold Cha

CeoEm
.12

By default, choices appear as a drop down list in your store. If you
wanted to change your choices to radio buttons, you can select an
alternative layout within the 'Layout' panel of the 'Size' attribute.
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Exercise - Choice-Dependent Pricing

This exercise will add a name tag option to the Gold Chain. When
customers purchase a chain, they will be able to choose between two
different sizes of tag - with each one being a different price.

1.

Go to the Product Options' panel of the Gold Chain again,
and click the 'Add a New Option' button.

Under 'Name of Option' enter 'Name tag' and then enter two
choices - 'Small' and 'Large'. Enter a price of £5.00 for the
'Large' option.

Mame of Option:
Mame tag Choices for Mam
if you want different combinations of options to be Small

priced differently (e.0. a customer will pay a certain E] Large
amourt when they select a certain size with a =
certain color)then select this box: =

[F] Farmbing thie with anathar aefioe s

Click 'Next' twice. In the second screen, carefully change the
'Select Layout for Options' drop down list to 'Standard Radio
Button List'.

Select Layout for Options
Mame tag Standard Radio

Mo Layout

Click 'Next' and then click 'Finish' to create the new option.

Length

ncn]5]

Mame tag

You now need to make a couple of changes to the 'component' Sellerdeck
Desktop has created in order to make the name tag optional (i.e. the
customer can choose not to buy one).

5.

Look at the options within the 'Gold Chain' product within
the content tree. You should have two components - 'Option'
and 'Optionl".
-3 Gold Chains
=R Y Gold Cha
.£|1'$® Optio
f—]{ﬁa Optio
=

Click on 'Option1".

Look at the details of the component, and change to the
'General' panel if you are not there already.

Select 'Is Optional' and also select 'Include ... in Attribute
Choice List', entering 'None' as the prompt.
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Component Details:
Component Mame; Option

HTHL far Mame:  Jption

Quartity Used: 1 =

[T Femnonent de Senarate Ordsr | ine

9. Change to the 'Permutations' panel.

M ame tag YWalid  Pricing Price Product
SEET |loveride | zo.00] [Nane

The main grid here is where you can edit prices if required.

10. Click 'Apply Changes' to confirm your changes.

Optionl
Name tag
™ None

More Information - Stock Levels

When you create options for a product, you have the option of entering
stock levels for your choices.

Mame tag Frice
Small |  £og
When you do this, Sellerdeck Desktop creates a 'hidden product' for each
choice.

=122 Gold Chains

=28 5] Gold Chain
L (Gold Chain fka
These hidden products contain the stock for each option. They are

associated with each choice within the Permutations panel of the
component. The associated product is in the 'Product' column in the grid.

Mametag  “alid  Pricing Frice Product
E] Srnall | |Eluerride | EEI.I:IEI| Gald Chain {M arme tag:Sm

So when your customers select a certain choice online, they are
effectively purchasing a specific hidden product.
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Brochure Pages

Brochure pages are optional information pages you can include with
your store pages such as 'Special Offers', 'Latest News' etc.

There are two example brochure pages supplied with Sellerdeck Desktop
- 'Home' and 'More Pages'. You will find these at the top of the content
tree. In the preview, you will see a list of the brochure pages in the
sidebar.

= Home
Welmame To
L i J@E Shecisl CFFer)

Brochure pages cannot contain products, but they can contain
'Fragments' - which are information items on a page. Sections can also
include fragments.

Exercise - Creating A Brochure Page

This will create a new 'How To Find Us' page in your store, and include
an example information item within it.

1. Right-click on the 'Home' page at the top of the content tree
and select 'New Brochure Page'.

2. Inthe 'Name' field enter 'How To Find Us'.

3. Inthe 'Button Image' field click 'Browse' and locate
'button_brochure_location.gif' in your 'Sitel' folder.

4. In the 'Button Rollover Image' field click 'Browse' and locate
'button_brochure_location_highlight.gif' in your 'Sitel'

folder.
Marne: Haw Ta Find Us
Button Imaage: buttorn_brochure_location. gif

Button Rallover Image: | button_brochure_location_highlight. gif

Meta Kewwords:

teta Dezcription;

These images are not used in the default Sellerdeck Desktop theme, but
they may be visible in other themes.

5. Click 'Apply Changes'.
This has created a new page in the content tree.
You are now ready to include a fragment into the page.

1. Right-click on your new 'How To Find Us' page and select
'New Fragment'.

2. Inthe 'Fragment Title' field enter 'How To Find Us'.
3. Inthe 'Text' field enter 'Here is how to find our offices....'

4. Change to the 'Layout' panel and change the 'Fragment
Layout' to 'Main Heading Above Text Left Of Image'.
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[z Fragment
Fragment Layout Use Parent (=5ul
Main Heading Abowve
Main Heading Abowve
Subheading And Text
Subheading And Text

5. Click 'Apply Changes'.

If you have a suitable image to use for e.g. a map then you can always
select it in the Tmage' field in the 'General' panel.

More Information - Links

If you are creating a fragment that refers to a product or a section in the
store, you can use the 'Links' panel to create a link to that item. Then just
include [LINK] in the 'Text' field, where you want the link to appear.
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Uploading Your Store

In order to really see your store in action, you need to upload it to a
website. This will publish your website to the internet, and you will be
able to use the search, shopping cart and checkout functionality, and
place test orders.

Exercise - Uploading a Trial Copy of Sellerdeck
Desktop

If you are using a trial version of Sellerdeck Desktop, which has been
pre-configured to work with a specific site, it is simple to upload it to the

internet.

1.

Press the 'Publish To Web' button (Q BRSNS on the
toolbar (or go to 'Web | Publish to Web').

You will be prompted to enter a username and password.

If you do not have a username and password then you will
need to register for one online.

e (lick on the 'To Apply For A New Account' link, and
follow instructions on the website.

e Once you have supplied the required information and
received a username and password, enter the username
and password into the fields provided in Sellerdeck
Desktop.

The upload should then continue.

Check and Send Files

‘\’ Checking HTML pages... 84 / 84
~ Checking catalog... 35 / 35
ﬂf Checking zearch indices... 4 / 4

‘1’ Sending baze files... 442 / 442
‘\’ Calculating file checksums... 253 / 263

The first time you upload, it will take quite a while as it needs to upload
the entire site. After that, however, Sellerdeck Desktop will only upload
the files that have changed.

Once the upload is completed, click the ] button on the toolbar (or go to
'Web | View Online Website') to view your store online.
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More Information - Uploading From Sellerdeck
Desktop To Your Own Website

The instructions in this section will work for most web sites, but they
won't work with all of them. If you find they don't work for your website
then you will need to contact your web hosting company.

When the Sellerdeck Desktop store is uploaded to your web site, all the
store files (with a few specific exceptions) are uploaded to two folders on
your website:

e 'CGI folder (often called 'cgi-bin') where all the script files
will be uploaded to in order to run the online search,
shopping cart and checkout. These files are sometimes
referred to as 'Perl files'.

e An online store folder, which Sellerdeck Desktop will create,
that contains all your store HTML files and images.

Note: The 'home' brochure page can be uploaded to the directory level
above the online store folder by selecting the 'Use as Web Site Home
Page' box on the 'home' brochure page.

Before you try uploading your store you need to know:
e The URL ('http:/ /") address of your CGI folder.

o Where the CGI folder is located on your web site (as it
appears when you connect via an FTP program).

You will also need to know:

e The URL and the FTP location of the folder on your website
that you would like Sellerdeck Desktop to create the online
store folder within.

When you have these pieces of information, you can start the 'Web Site
Configuration Wizard' by going to 'Web | Configure Web Site Details'.

Introduction

This wizard will step you t
configuration process. Tt
but this wizard is designet
Catalog will make every
corfiguration. K you hawe
Intemet connection, plea:

[#] Configure Tew Tetwo
unchecked, the wizan
settings. .o

[| Corfirm Each Setting.

Actiman th—d amn ba -

The Web Site Configuration Wizard will ask you for your username and
password to connect to your website, and will ask you to confirm the
locations, and the http addresses, of the folders mentioned above.
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You can often just accept the defaults to achieve a successful upload.

When the wizard has finished, you can review the settings at any time by
going to 'Web | Network Setup'.

From now on, simply click the @ PubishtaWeb 1y tton on the toolbar to
upload your store.

For more detailed information on uploading, open the main help and go
to 'Putting Your Store Online'.
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What’s New in Sellerdeck
Desktop v18?

See the main help for more information about the additions listed here.

Wish List

The new Wish List feature in Sellerdeck Desktop v18 enables each of
your customers to create a Wish List or Gift List, for their own personal
use, or to share with their family and friends.

Every list is private unless the user chooses to share it. Items from the list
can be purchased either by the user, or anonymously by someone they
shared it with. Once purchased, an item cannot be ordered from the same
list again, unless the number required is greater than the number
purchased.

Marketing

Customer Feedback - the Feefo integration is upgraded to support the
Feefo v3 platform; offering better performance, updated logos and star
ratings in review content.

Rich snippets - structured data is embedded into each site page in a
search engine friendly format. This enables Feefo ratings, product prices
and product availability to appear in search results.

Google Shopping - the feed is upgraded to support separate entries for
product permutations; additional fields enable all product types,
including apparel, to be supported.

Facebook Tracking Pixel - easily add the code for your tracking pixel
and track the performance of your Facebook adverts.

Checkout

Checkout entry is upgraded to follow current best practice; with options
to check out as guest, create account, or log in direct from the checkout

page.
New cart and checkout layouts provide improved appearance and
behaviouf on mobile devices.

Checkout error messages are shown in context to reduce dropout rates.
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Navigation

Filtering on Search Results - allow customers to filter the results of free-
text searches using variables such a Price and Brand.

Filter Options - new accordion layout improves visibility and usability
particularly when there are more than a few filters.

Carousels and Mega Menu are upgraded to provide better usability on
touch screens.

Security

Site security is improved with options to upload using Secure FTP (FTPS)
and send emails from the website using TLS.
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Running an Online Business

Business Settings

'Settings | Business Settings' is where you can enter details about your
company and how you do business.

r
Business Settings

5
E —| Company

Name; Sample Company Customer Service Numk
Address Registration Information
L{S\'—t@ My Strest Tax 1 Description: My’
Options Tax 1 Number:
L% My Town Tax 2 Description:
Synchronisation fax 2 Homsbr:
= FostCnk Credi Cond Gompary Rel
= Courtry: United Kingdom &
Ordering

m

Contact

Order Processing i My Cortact
u Job Tile: My Job Title
Pa}'merrt;nd Security Phone Number: My Phone Number Fax Number:

e Email Address:  YourName@YourCompanyEmaill.com  \Web Site Address: ¥
g—j Embedded Map

Tax s

[ Show Map in "About Us' Section [ Show Map on Contact Us' Page

You can also set up how you will take payments and charge postage,
which are both discussed in later chapters.

It is essential to communicate clearly with your customers on the site
about who you are, where you are based, how long it's going to take to
fulfil orders etc. This builds trust in your potential customers, and makes
them feel more comfortable about placing an order with you. It also helps
set expectations of customers about delivery times etc.

Sellerdeck Desktop's main way of communicating all this information is
via an online 'Terms and Conditions' page. This is linked to from every
page, including the checkout, and contains all the information about who
you are and how you do business. Contact information is also included
on the online receipt, and all emails and reports generated by Sellerdeck
Desktop.
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Exercise - Entering Company Contact Data

This exercise will show you where to enter your company details into
Sellerdeck Desktop, and also enter information into an online terms and
conditions page.

1.

7.
8.

Go to 'Settings | Business Settings' or click the 65 Business Settings
button on the toolbar. Make sure you are on the
'Company/ Contact' panel.

In the 'Name' field, enter your company name.

In the 'Address' and 'Post Code' fields, enter your address.

Compary
Mame: My Compary
Address
Iy Strest

My Town

In the 'Contact' area at the bottom, enter your name into the
'Name' field.

You can delete whatever is in the 'Job Title' field - or change
it to suit your requirements.

Enter a phone number in the 'Phone Number' field and an
email address in the 'Email Address' field. You can also enter
a telephone number into the 'Customer Service Number'
field at the top.

Enter your website address into the 'Web Site Address' field.
Click 'Apply'.

Now you have entered some company details, you can enter some terms
and conditions information.

9.

Change to the 'Terms and Conditions' panel.

10. In the 'Delivery Schedule' tab, change 'We deliver your order

right away' to 'Where possible, we will always ship orders
the same day they are received'.

Credit Card Security I Guarartes
About Us | Making a Purchase

Where possible, we will always ship
in =days: business days. Intemationg

You must inform us within two warkin
prompt claim against the delivery con
comespandence.

11. Feel free to make any other changes to the text in the tabs.

You can now check the results in the preview.
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12. Go to 'Web | Preview Store' or click the ©! button in the
toolbar. Make sure you are previewing the whole store and
not just the current page.

13. Click the 'Terms & Conds' button (or 'Terms' or 'Info' or
whatever it is called in the theme you are using) to check out
your changes.

Exercise - Tax

In 'Business Settings' you also set up whether you want to enter your
product prices including tax or excluding tax.

1. Go to the 'Company/Contact' panel in 'Business Settings'.

2. Change the 'Tax 1 Description' field to read 'VAT Number'
(or equivalent if you charge an alternative type of tax e.g.
'Sales Tax #').

3. Inthe'Tax 1 Number' field, enter your company tax
registration number.

4. Click 'Apply".
Now change to the 'Tax' panel.

5. On the Tax panel, under 'Product Prices Entered', select
'Inclusive of Tax'.

Product Prices Ertered
@) Exclusive of Tax ) Inclusive of Tax|

This means that you can enter prices for your products including tax, and
Sellerdeck Desktop will separate out the tax in the online shopping cart
and in the order.

6. Click 'OK!, or if you want to go back to entering prices
without tax click 'Cancel'.

To find out more about configuring tax, look at the chapter called 'Setting
Up Tax', within the 'Business Settings' section in the main help.

More Information - Advice On Selling

The most important aspect of selling online is how effectively you
communicate with your customers - both on the site as they customers
are browsing, and also after the order has been placed. A missing postal
address for your company, or unclear information about delivery times
will lose you more orders than a design element that is slightly out of
alignment. So take the time to get your terms and conditions right, before
getting into the more technical aspects of the Sellerdeck Desktop store.
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Taking Payments

Sellerdeck Desktop offers a wide range of options for you to take
payment from your customers. For processing card payments we
recommend using a 'Payment Service Provider' such as Sellerdeck
Payments or PayPal.

A 'Payment Service Provider' (PSP) is a company that will take your
customer's card details online, and process them there and then. They
will also take care of compliance with PCI DSS, the Payment Card
Industry Data Security Standard. You will then download the
confirmation that tells you the customer has paid. Sellerdeck Desktop is
integrated with a large number of PSPs, including 'Sellerdeck Payments' -
its own payment service.

Exercise - Adding a Payment Service

This exercise will show you how to integrate your store with an online
payment service. In this example, we will be using Sellerdeck Payments.

1. Go to 'Business Settings | Payment and Security'.
2. Click the '+' at the top left of the main grid.

3. Inthe new row created select 'Sellerdeck Payments
Ecommerce' from the drop-down in the 'Payment Method'
column.

Fayment Methods

Payment Method W
Credit card details sent separat... |Cre

Invoice with order [
| SellerDeck Payments Ecomm | Cre

=llerLleck Fayments BEco =

\adbdndED

If you want to integrate with a different payment service,
select an alternative one from the list.

4. Edit the 'Web Site Description' field to change how the
option will be presented to your customers at the web site.

5. Now click 'Configure Method'.
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-

Payment Service Provider Configuration

Wwieb zite description:

Provider

Operation
(71 Bun in production mode
@ Run ik test mode

Tranzaction
() Pre-authorize transactions

@ iCharge ranzachions imrmediate)y

PSP zettings

Terminal (D

Tranzaction K.ey

Credit Or Debit Card

SellerDeck Payments Ecommerce

Hazh Kep
Wby O’ 2 [ Enfaorce - ]
Yerfy Address | Check. - I

This is where you can enter details about your account with the payment
service. Click 'Information and Registration' if you want to apply for a
test account to try it out with.

If you don't have any settings to enter here yet, just click 'Cancel' and
remove 'Sellerdeck Payments' from the list of payment methods (by
right-clicking on the grid and selecting 'Delete Row").
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Shipping Charges

Sellerdeck Desktop allows you to charge your customers for shipping
their order to them. There are two approaches to charging for shipping;:

e Use a simple rate that is easy for customers to understand.

You could base this on the kind of products being ordered,
or the number of items in the order.

e Use a more sophisticated calculation system that works out

more precisely what the order will cost to ship, and passes
that cost onto the customer.

However you want to charge shipping, Sellerdeck Desktop has a range of
tools to meet your needs.

For companies shipping large order volumes, the Integrated Shipping
function provides for automated printing of labels and manifests and
committing of shipments to carriers, using the GFS shipping service.

Exercise - Calculating Shipping Based on the
Weight of the Order

This exercise will show you how to calculate shipping based on the
weight of products in the order. If you intend to use the Integrated
Shipping function, this method is required.

1.

Within 'Business Settings | Shipping and Handling |
Zone/ Class Tables', click on the 'Test' class you created in the last
exercise.

Now change the 'Basis' drop down to 'Weight in kg'.

Click the '+' at the top-left of the grid that has appeared. In the
new row, enter a weight of '0.25' and a cost of '£2.00". This means
that orders that weigh up to 0.25 kg will be charged a cost of
£2.00.

Add another new row that has a weight of '0.50' and a cost of
'£3.50". This means that orders that weigh between 0.26 kg and
0.50 kg will be charged a cost of £3.50.

Add another new row that has a weight of "1.00' and a weight of
'£5.00'.

FPackage Cost

Upto'weight in kg Cost DMF'E P
Wwieight i

] 0.25 £2.00

] 0.50 £3.50

> T T

|

>

>

= Excess

= O Don

You now need to handle what will happen with orders that weigh over

1.00kg.
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6. Change the 'Excess' setting to 'Highest Table Value'.

This means that anyone with an order that weighs more than 1.00 kg will
be charged no more than £5.00.

Finally you are ready to enter some weights in for your products. This is
done in the 'Weight in kg' field at the bottom left of the product 'Details'
panel.

Exercise - Charging Shipping Based on the Type
of Product Being Shipped

This exercise will show you how you can set up basic shipping charges
just for the rings in the example store, which will be different from the
charges for the other products.

To start with, you are going to create a new 'Shipping Category' called
'Rings' and then place the three products in the 'Rings' Section into this
category.

1. Go to 'Business Settings | Shipping and Handling'
2. Change to the 'Product Shipping Categories' tab.

3. (Click the '+' at the top left of the grid to add a new row to the
grid.

4. Inthe new field enter 'Rings'.

S —
! Corfiguration Froduct Shipp
Shipping Categaories

Shipping Categony
Marmnal
[T e s sl

YV ¥ Y Y ¥EFEE

Click 'OK' on 'Business Settings' to close it.
Now click on the 'Three Diamond Ring' product in your tree.

Change to the 'Details' panel.

© N o »

Change the 'Shipping Category' for this product to 'Rings'.

Shipping Category:

9. Click 'Apply changes'.
10. Repeat this for the other two rings.
You can now enter some shipping charges for the rings in your store.
1. Go back to 'Business Settings | Shipping and Handling'.
2. Change to the 'Zone/Class Tables' tab.

3. In the white box to the left, right click on the 'UK' zone and select
'Add Class | New Class...".
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Zone/Clazz Configuration
Mew Zone...
+Nt Add Class » Example - In
- R [
B Example Cla
Example Cla

If you don't have 'UK' in the box, you could use any of the countries you
see there.

4. Give the new class a name of 'Test' and click 'OK'.

5. With 'Test' selected in the white box, change the 'Basis' drop

down to 'Category'. A grid should appear in the 'Zone/Class
Tables' tab.

B asis: Categorny

T ax Applies to Shipping Shig
Order Cost
Shipping Category Fixed Charge Fe
Mormal £5.00
Rings £1.00f.

6. In the 'Normal' row, enter a 'Fixed Charge' of '£5.00' and a 'Per
Item Charge' of '£1.00'.

7. Inthe 'Rings' row, enter a 'Fixed Charge' of '£1.00' and a 'Per Item
Charge' of '£2.00'.

8. Click 'Apply".

The rings will now incur a different shipping charge from the other
products in your store.

Exercise - Setting Up Free Shipping for Specific
Products
It is simple to give certain products free shipping.

1. Go to the 'Details' panel of a product that you want to have free
shipping.
2. Select the 'Exclude from Shipping Band Calculation' checkbox.

[w|EE=clude From Shipping Ba

3. Click 'Apply changes'.
This product will now be exempted from any shipping charges.

You can also enter a value in the 'Shipping Supplement' field here if you
want a product to always cost a specific amount to ship.
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More Information - Shipping By Volume

Sellerdeck Desktop supports calculating shipping charges based on the
dimensions/volume of the order.

You can enter a 'volume' value in the 'Volumetric Weight' field within the
'Details' panel of a product. Then you can set the calculation basis for a
particular shipping class to 'Alternative Weight' using the 'Basis' drop-
down within the 'Zone/ Class Tables' drop down list. Then fill in a table
of values in the same way as for weight - as described above.
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Marketing and Promotion

Best Sellers and New Products

'Best Seller Lists' and 'New Products Lists' are list of products that can
appear on every page (or just on specific pages) to promote certain
products to your customers.

Best sellers lists work out the best selling products from the orders that
have been received, and display them as a list in the store. The best
selling items in your store are the ones that most people will come to
your site to buy, so by displaying them prominently in your store you
will help customers find them more quickly, which will hopefully turn
into more new orders.

New products lists are made up of the newest items that have been
added to the store. It is important to keep displaying your newest
product lines as this keeps your store content current and up to date and
hopefully gives customers a reason to keep coming back to your store.

By default in the example Sellerdeck Desktop store there is a new
products list in the sidebar of every page, and also on the brochure home

page.

Exercise - Adding A Best Sellers List
This exercise will add a 'Best Sellers' list to your store pages.
1. Go to 'Marketing | Best Sellers'.
2. In the 'Include Sales from last' field, enter '999'.
3. Click 'Generate Now'.
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-
Best Sellers

[¥] Enabled

Mumber of Products in Lists 5

Period of 5ales to Process

@ Include Sales fram last 999 Days

7 Include Sales from 070142013 o mam

Auto-Generate Ligt on Upload

@ Ewvery 1 Days () Every Uploac

Best Sellers List

Order Product Lock
1[May - Emerald O
2| Diarmond Pendant |

FHkdnilh Paarl Brarslst (I

This will search through the demo orders that are in Sellerdeck Desktop
and work out the best selling items from that.

4. Change the 'Include sales from last' field back to '30' and
click 'OK".
5. Now click 'OK' and look at your site in the 'Page Preview'

panel. You should see a best seller list in the sidebar of every
page, and also one on the home page.

Best Sellers
May - Emerald Diamond Pendant
£30.00 1 £96.00
find out more __',:\--—-:-_ find out more

6. Now go to 'Marketing | New Product Listing'.
7. Click 'Generate Now'.

8. Click 'OK' and you should see the 'New Products' list in the
sidebar of each page.

New Products

Golden Heart Meq

£102.00
A beautiful emerald

fnr wons nr woar lnws
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Exercise - Changing Where The Lists Appear

This exercise will allow you to control where the best sellers and new
products lists appear in the store.

1. Go to 'Settings | Site Options' and change to the 'Layout'
panel.

2. Find the 'Best Sellers List' sub-heading at the bottom of the
grid.

3. Change the 'Location For Best Sellers List' setting to 'Home
Page Only".

4. Now under 'New Products List' change the 'Location for
New Products List' setting to 'Sidebar Only".

= Best Sellers List
Best Seller Item Layout (For Section Pages) Uze Parent (=Co
Best Seller List Layout (For Sidebars) Best Sellers List ¥
Best Sellers List Layout (For Section Pages) Tabular Best Sell
Location For Best Sellers List Sidebar Only
= Feefo Uze Parent (=Both
5. Click 'OK'".

You should now have best sellers list appearing on the brochure home
page and the new products listing appearing in the sidebar of every

page.

Note: If you try and change the 'New Products List Layout (For Sidebars)'
or the 'Best Sellers List Layout (For Sidebars)' it doesn't change anything
in the default theme, but it will have an effect in other themes.

More Information - Customising the Lists

If you go to the grid at the bottom of 'Marketing | Best Sellers' or
'Marketing | New Products Listing' you can click on any item in the list
and use the drop-down list to manually change it to a different item.

You can also click the 'Lock' checkbox to fix that product in the list and
let all the other products auto-generate around it.

Best Sellers List

Order Froduct Lock

1|May - Emerald ]
2 |Diamond Pendant ]
3| Multi Pearl Bracelet ]

If there is a certain product that you don't want to appear in the
marketing lists, de-select the appropriate checkbox within the 'Marketing'
panel of the product.

[nchude in Automatic Listz

|iBest Sellers 41 Mew Product
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Related Item Lists and Also Bought Lists

As well as the best seller lists and the new products lists, it is also
possible to place some marketing lists underneath the products in the
store. There are two types of these lists:

¢ Related Product lists - where you can set up a list products
that are all related in some way to a certain product.

o Also Bought lists - these are automatically worked out by
Sellerdeck Desktop. Sellerdeck Desktop can take a product in
your store, then look at all the orders that include that
product, and then look at what else the customers order.
These then become a 'customers who bought this also
bought...' list underneath the product.

As well as appearing underneath products in the store, these lists can
also appear on the shopping cart page in the online store. That way,
customers can see some products that are related to the products that
they already have in their shopping cart.

Exercise - Creating a Related Products List

This exercise will include a related products list for the 'Diamond
Pendant' product in your store.

1. Go to 'Marketing | Related Products'.

2. Select 'Enabled'.

3. Click 'OK".

4. Now go to the 'Diamond Pendant' product (within the
'Necklaces' section).

5. Go to the 'Marketing' panel and click the '+' at the top left of
the 'Product Related Products' list.

6. In the row created, type “sol” into the Product column and
choose 'Solitaire Diamond Ring' from the drop-down list.

This is an example of how you might use the related products list to
create an upsell from one product to another.

7. Now click the '+' and type ‘gol’, and this time select 'Gold
Chain' from the list.

Fraduct Related Products List

lil Order Froduct
[E] Solitaire Diamo

E] 2| gol

2

E: ") Gold Chair
8. Click 'Apply Changes' and check out your changes in the
preview.
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Exercise - Also Bought Lists

This exercise will generate 'customers who bought this also bought...' lists
into your store, and show you how to change the layout of them.

1. Go to 'Marketing | Also Bought...'
2. Select 'Enabled'.

3. Change the 'Include Sales from last' field to '999' and then
select 'Generate Now'.

F

Also Bought List Generation

ﬂf Generating Product Also Bought Lists

This will generate a list for nearly every product in the default store.

4. Change 'Include Sales from last' back to '30' and click 'OK".

5. Go to the 'Marketing' panel for the 'May - Emerald' Birth
Stone Earring product.

You should see that some products have been automatically added to the
list. These products will appear in a fairly standard numbered list by
default, but there is an alternative layout option.

6. Go to 'Settings | Site Options | Layout'.

7. Under the 'Product' sub-heading, find the 'Product Also
Bought Item Layout' setting.

Price Layout for Online Customer Prices Use Parent (=On
Product Also Bought Item Layout Compact Also B
Product Image Layout Compact Also B
Product Layout Regular Also Boy

8. Change this setting to 'Mini Also Bought Item' and click 'OK".

This should include an image, price and description into the also bought
list for the 'May - Emerald' Birth Stone Earring.

People who bought this also bought:
Gold Chain

%“l'ﬁ% £96.00 ﬂ

The related items list also has an equivalent layout option.

More Information - Lists in the Shopping Cart

Once you enable either related item lists or also bought lists you will see
a list appearing in the online shopping cart underneath the grid of

Getting Started Guide Marketing and Promotion e 45



products. These lists show the related products and also bought products
for the product that is currently in the shopping cart. If there is more than
one product in the shopping cart, then Sellerdeck Desktop will merge all
the related products and also bought products into a single list.
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Recently Viewed Products Lists

Sellerdeck Desktop's 'Recently Viewed Products' list enables visitors to
your site to return easily to any product they have viewed before. It
differs from the other marketing lists in two ways:

e Itis generated in real time on the web site, instead of being
generated locally and uploaded.

e Each visitor to your site sees their own individual list, based on
which products they have viewed.

Recently Viewed

—

Exercise - Creating a 'Recently Viewed' List

This exercise will show you how to enable a 'Recently Viewed Products'
list for your customers.

For the list to work effectively you should have Product Page generation
enabled in Business Settings | Options | Miscellaneous, and for each
individual product. This is the default setup for all new stores.

1. Go to 'Marketing | Recently Viewed Products'.

Recently Viewed Products

[ &dd Product to List When Extended Information Page is

Tick thiz option if pou are wzing a single product per pag
oh Extended Information pages.

[ Add Products to List When a Section Page is Viewed

Thiz aption warks best if each praduct in your catalogue
Pleaze zee the Help Far mare details.

Only Add a Product to the List if it iz the Only [bem on

Mumber of Products to Show at a Time 4

[] Shove the Full Retail Price of Each Product in the List

9. If you want to show product prices in the list, tick 'Show the
Full Retail Price of Each Product in the List . NB if your store
pages are set to show discount prices to account customers,
the 'Recently Viewed' list will still show the full retail price.
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10.
11.

12.

13.

Click 'OK".

Go to 'Settings | Site Options', click on the 'Layout' panel and
scroll down to the 'Recent Products' section.

Here you can change 'Recent Products Display' to select a
more compact or vertical layout. There are also settings to
change the price displayed from tax-inclusive to tax-
exclusive; and change the type of image used in the list.

Site Options
General —
o
Links Cart Product Details Cart Prod
Extended Irformation Invoice Country List Invoice g
Design Wizard Invoice State List Invoice Si
Product Page Site Search Results Layout Use Parer
MegaMenu = Recent Products
ju] ol =] d 0 et T 1 =] 1 of

Click 'OK' to save any changes.
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Customer Feedback

Sellerdeck Desktop includes a built-in integration with Feefo, an
independent customer feedback service that enables you to automatically
request feedback from your customers, display ratings for your products
and/or your service, and provide links to their comments.

feefo® &4

Exercise — Enabling Customer Feedback
To enable and configure customer feedback for your site:

1. Select 'Customer Feedback' from the 'Marketing' menu.

Customer Feedback Configuration

[¥] Enable Customer Feedback

Merchant Identifier:

Password:

Test Settings |:
[#] solicit Feedback Privacy Settings

Before requesting, wait 7 day(s) from (1
@

[¥] Indude Reguests for Mail/Telephone Orders
[¥] Display Site Feedback [¥] Display Prod:

Auto-Refresh Cached Feedback on Upload
@) Every 1 Days () Every Upload

Refresh Cached Feedback Mo

Transform Feedback to HTML Using:  feedbadk

Product Link

2. Click the 'Information and Registration' link at the top of the
dialog.

3. Follow the link provided to obtain a preferential rate when
you sign up for a Feefo account.

4. At some point during the sign-up process you may be asked
to provide your ‘Product Link’. To do this, click 'Copy to
Clipboard' under the 'Product Link', and then paste into the
web form or email as instructed.

5. When you receive your account details, return to the
'Customer Feedback Configuration' dialog and tick 'Enable
Customer Feedback'.
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10.
11.

Enter the Merchant Identifier and Password you were given
into the fields provided, and click 'Test Settings' to make sure
they are correct.

Check that 'Solicit Feedback' is ticked to start requesting
feedback automatically. Feedback will be emailed to the
address you provided when you registered for your Feefo
account.

To get feedback from recent customers to help get you
started, click on the 'Click to Send' button. This will request
feedback from anyone who purchased from you in the last 3
months.

If you do not want to display ratings for your service or your
products, untick 'Display Site Feedback' and/or 'Display
Product Feedback' as appropriate.

Click OK.

To change the logos used to display feedback scores, select
'Site Options' from the 'Settings' menu. Click on the 'Layout'
tab and scroll down to the 'Feefo' section.
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Mailing Lists

Sellerdeck Desktop gives you the ability to easily extract your customers'
contact details out of Sellerdeck Desktop. This information can then be
imported into emailing programs like Microsoft Outlook or GroupMail
in order for you to mail your customers with promotional material.

This feature can be found at 'Marketing | Mailing Lists'.

Web Housekeeping
d Best Sellers...

Mew Product Listing...

Also Bought...

Related Products...

NI 1T

Recently Viewed Products...

Discounts and Surcharges Settir
i'@ Customer Groups...
Product Groups...

Sellerdeck Desktop allows you to filter your customers' contact details
based on when they placed orders; what the status of the order is; what
products were ordered; where the customer is located; and how large the
order was. You can also print mailing list information onto labels and
envelopes.

Exercise - Creating a Mailing List

This exercise will show you how to build a mailing list based on the three
example orders that are in the 'Orders' tab in Sellerdeck Desktop.

1. Go to 'Marketing | Mailing Lists'.

Mailing Lists
| Order Detailz I Options
Main Select Products | Product Search
Dates:
@ Order Placed ) Order Completed () Order Recejved
From: 26 February 2010 B~ 000000 =
To: 26 February 2010 B~ 235959 =
Payment Status:
Crder Payment Status: [ﬂn',' hd
Include Address Details From:
Invoice Address  [] Delivery Address Only when ¢
[]Only Include Orders From Registered Customers
Filter On "Keep Details Private™ Fitter On User Defined A
11 lear A=fimshla 1

2. Under 'Order Status', de-select 'Complete' and select 'Any'.
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3. Inthe 'From' field, choose a date that is older than the

example orders in

your store.

4. Make sure that 'Order Payment Status' is set to 'Any'.

5. Click the Preview

List' button.

Preview:
E-mail Address Mame First Nan
sarahjones@yourcompanye... Sarsh Jones Sarah

This shows you the two sets of customer data that are ready to export.

6. Inthe 'Format' field, select 'Standard Format'.

7. Click the '..."' button next to the 'Filename' field.

8. Browse to your computer's desktop and enter 'export.csv' in

the 'File name' field. Click 'Save'.

9. Back on the 'Mailing Lists' window, click the 'Export List'

button.

Sellerdeck Desktop automatically removes any duplicate records, based

on the email address supplied with the order.

Exercise - Advanced Filtering

This exercise will show you how to filter the mailing list based on
whether customers have ordered the 'Diamond Pendant'.

1. Go to 'Marketing | Mailing Lists' and go to the 'Select

Products' tab.

2. Click 'Get Products'.

3. Inthe tree, click the '+' next to 'Online Catalogue'. Then click
the '+' next to 'Necklaces'.

4. Select the 'Diamond Pendant' checkbox.

&-T]

=]  Online Catalogue

Rings
Mecklaces
Lockets

(zolden Heart Ne
Diamond Pendar

5. Now go back to the 'Main' tab and make sure that the 'From'
field is set to some time before today’s date.

6. Finally, press the 'Preview list' button to update the list. It
should contain 'Sarah Jones' and 'Susan Jones'.

Filtering can also be done on location (in the 'Location Lookup' tab) and
order size (in the 'Order Details' tab).
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Social Media

Sellerdeck Desktop provides built in features to help you promote your
site via the major social media - Facebook, Twitter, Google Plus, Pinterest
and YouTube. These are configured via the ‘Social Media” tab of the ‘Site
Options’ dialog, which is accessed from the ‘Settings” menu.

Site Oiptions

General
Layout = General
Links Follow Buttons Position Use Parer
Extended Information Follow Buttons Style Use Parer
Design Wizard Page Share Buttons Position Use Parer
Product Page Product Share Buttons Position Use Parer
MegaMenu Share Buttons Style Use Parer
Properties Social Media Badges Position Use Parer
Fittering Social Media Badges Style Use Parer
Page Settings £ Twitter
Shopping Cart Initial Text For Tweets Use Parer
Social Media Show Tweet Counts Use Parer
Stock Show Twitter Follower Count Use Parer
M Tweet Button Hashtag (Excluding The #) Use Parer

Your Twitter User Name (Excluding The "@")

= Facebook
Facebook Page:  https://www .facebook.com/
Facebook admin (Cptional)

Exercise - Adding Facebook Links To Your Site

This exercise will show you how to add Facebook ‘Like” and ‘Share’
buttons, and a link to your Facebook page. The steps for adding links to
other social media are similar.

1.

S

Select ‘Site Options’ from the Sellerdeck Desktop ‘Settings’
menu and click the ‘Social Media’ tab.

Scroll down until all the Facebook settings are visible.
Enter the address of your Facebook page.
Change “Show ‘Share’ Button” to ‘“True’.

Click “OK’ and check the page preview. You should see a
badge in the page header, which will link and to your
Facebook page; and ‘Like” and ‘Share” buttons, which enable
you and your site visitors to Like the current page or Share it
on a Facebook timeline.

Rings Nec
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Order Level Discounts

Order-level discounts allow you to create discounts in the store that are
triggered by how much the customer has spent online. For example, you
can use this to create a discount that says "10% off all orders" or "£10 off
all orders over £75".

Exercise - Creating a Discount Based on Order

Value

This exercise will create a 'weekend sale' where all orders have 10% off
within a set time period.

1.

Go to the 'Marketing' menu and then select 'Discounts and
Surcharges Settings...".

Go to the 'Order Level' tab (if you are not on it already).

Click the 'New' button at the right and enter a name for your
discount of 'Weekend Sale'.

Orcer Love

Discounts:

Description:
Weekend Sale

[ New | [ Bemo

Change the 'Based On' field to 'Cart Value Including Default

Tax'.

Change 'Type' to 'Percentage'.

In the 'Triggers' grid click the '+' at the top left and enter a
value of '10' in the 'Percentage’ field.

Click 'Apply".

Discounts Surcharges and Coupons Settings

Order Level |Cart Contents | Customer Pricing | Miscellaneou5|

s e ]
e Properties:
o Enabled  BasedOrc  CartWalue Including De

[ New ] [ Remove ] 7] Requires Coupon Code:

?n:le.r Adjustment Bample (@ Accept Standard Coupon Codes

Accept Single-Uze Coupon Codes Di
Triggers
E Cart Yalue Amaount Percentage
E G S |
-
-

This will put a discount on your store right away, so before you upload
and test this, you are going to restrict the discount to only being for this
coming weekend.
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8. Change to the 'Restrictions' tab (within the 'Order Level' tab).
9. In the 'From' field select the upcoming Saturday.
10. In the 'To' field select the upcoming Sunday.

Drate Bestriction

Walid From:
W] 27/02/2011]

Walid Until
11. Click 'OK'

There will now be a 10% discount on all orders placed at your store for
the coming weekend.

Note: you may want to remove this discount if you are about to put your
store live!

More Information - Restricting Discounts

In the exercise above you restricted a discount to a date range. You don't
have to set both the 'For' and 'To' fields - you can set one or the other if
you want to start a discount now and end it on a certain date, or start a
discount on a certain date and let it run indefinitely.

Additionally, in the 'Restrictions' tab you will see a 'Restricted to
Customer Group' grid. If you wanted a discount only for your retail
customers or for specific customer groups you can use the grid to set it

up.

Customer groups are discussed in a later chapter.
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Advanced Discounting

As well as creating discounts based on order value, Sellerdeck Desktop
allows you to create discounts that are based on the items that are in the
shopping cart. This allows you to set up discounts such as '3 for the price
of 2' and 'Buy any three books for 5.00'".

There is an example '3 for the price of 2' discount already set up in the
'Cart Contents' tab in 'Marketing | Discounts and Surcharges Settings'.

Also, you have the option to activate any of the discounts by customers
entering a specific coupon code online. You can create coupons that can
be used multiple times ('Standard' coupons) or once only ('Single-Use'
coupons).

Exercise - Buy Two For £45

This exercise will create a new 'Fixed Price' discount for the 'Birth Stone
Earrings' products that are in the default database. The first thing you
need to do is tell Sellerdeck Desktop that all the birth stone earrings are
related to each other. This is done by putting them both into a 'Product
Group'.

1. Go to the 'Marketing' menu and select 'Product Groups'.
2. Click 'New' and enter a name of 'Birth Stone Earrings'.

3. Select the 'April - White Topaz' product from the right-hand
list and use the '<' button to move it to the 'Members' list.

4. Do the same for the other eleven Birth Stone Earrings.

Product Groups

Groups Froduct Azzignments
Group Hame: Members

April - White Topaz [32)

August - Peridot [36]
December - Blue Topaz (40)

Mew ] [ Bemove February - &rmethyst [30)

Jarwary - Gamnet [29)

July - Ruby [35]

June - Pearl [34)

karch - Aquamaring [31]

May - Emerald [33] =

Maovember - Yellow Topaz [39]

October - Opal [38] >

September - Sapphire [37]

Birth Stone E arringz

5. Click the 'Discounts' button and click 'OK' on the message
that appears.

You should now be on the 'Cart Contents' tab within 'Discounts and
Surcharges Settings'.

6. Click 'New' and enter a discount name of 'Birth Stone
Earrings Offer'.
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7. Change 'Based On' to 'Quantity’.

8. Inthe 'Trigger' field, enter '2'.

9. Change 'Product Group' to 'Birth Stone Earrings'.
10. Change 'Reward Type' to 'Fixed Price'.

11. Inthe 'Reward Amount' field enter '45'.

General | Restrictions | Presentation |

Properties;
[V]Enabled  BasedOn:  Quantity -
[7] Frequires Coupan Code:

(@ Accept Standard Coupon Codes

Accept Single-lse Coupon Codes Dizplay Coupons
Product Group Birth Stone E arrings
Rewards:

12. Click 'Apply'".
13. Change to the 'Presentation' tab.

14. Enter the following text: 'Buy two birth stone earrings for
only £45.00'.

15. Click 'OK".

The offer will appear underneath the description of each qualifying
product in the preview, and will also appear in the shopping cart.

Exercise - Coupons

This exercise will set up a discount that is only triggered when customers
enter a coupon code online.

1. Go to the 'Order Level' tab within 'Marketing | Discounts
and Surcharges Settings'.

2. Highlight the 'Weekend Sale' discount you created in the last
chapter.

If you don't have this discount set up, then highlight the 'Order
Adjustment Example' discount (which is in the default database) and
select 'Enabled'.

3. Go to the 'General' tab and Select the 'Requires Coupon
Code' box.

Enter a coupon code of '12345'.
Click 'Apply'.
Now change to the 'Miscellaneous' tab.

Under 'Coupon Codes' select 'Store Pages'.

Click 'OK'

® N o g B
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Coupons

If wou have a coupon fo
then erter it here:

This should insert a coupon entry field into the sidebar of your store
design.

More Information - Offering Products as
Rewards

One of the Reward Type' options you have in the 'Cart Contents' tab of
'Discounts and Surcharges Settings' is 'Money off extra product' and '%
off extra product'. These allow you to offer customers free/cheaper
product as part of a promotion.

The 'extra product' in question is any product from a specific product
group that you have set up in Sellerdeck Desktop. If you want just to
offer a specific single product then you will need to create a product
group that just contains that one single product.
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Day to Day Administration

Retrieving Orders

To retrieve any orders placed at the store, click the 'Retrieve Orders'
button on the toolbar (GiRetrisveorders) or go to 'Operations | Retrieve
Orders'. Sellerdeck Desktop will connect to your store and see if there are
any orders on the site waiting to be retrieved. It then downloads them
and lists the orders within the 'Orders' tab. You can view the details of an
order by double-clicking on it.

Some people check for new orders throughout the day. If you are not
expecting that many orders to be placed at your store, you can just check
your email inbox for 'New Catalog Order Received' notification emails.
This email is sent just after the first order is placed after the most recent
order download. You will then know there is at least one order to
download.

Note: You must select the 'Send me an Email When I Have an Order to
Download' checkbox in 'Business Settings | Ordering' to have this email
sent to you.

Exercise - Downloading and Viewing Orders

This exercise will show you how to download and view order details
with Sellerdeck Desktop. You need to have placed some test orders on
the site in order to have anything to download.

1. Once you have placed one or more test orders at your
Sellerdeck Desktop store, switch to the 'Orders' tab.

2. Click the 'Retrieve Orders' button ((4 Retrieve Orders) on the
toolbar.

3.  Your order should then be listed in the list on the 'Orders'

tab.
_?E,i Currtent__z_ﬂ Design | & Orders
|| Order Mumber User
|| | DEMO0000000003

Note: There are three demonstration orders already in Sellerdeck
Desktop.
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4.

8.

Double click on your new order to open it.

Order: DEMO0000000001

| Lire [tems i Shipping and Handling I Tares i Totals I Progrezs And Payments
Irvoice Contact Delivery Contact
S alutation: [ Keep details private Salutation:
First Mame: Sarah First Mame: Saral
Last Mame: Jones Last Mame: Jone
M arme: Sarah Jones I anne: Saral
Title: Tithe:
Company: Company:
Address: Aryhers Address: Ay
Ciby/ T avar: Ayt City T awur: Arte
Postal Code: ANY 123 Postal Code: ANy
Countoy: United Kingdom Country: Unite
Phone: 01234 5E7A90 Phone: m23
Mobile: Fobile:
Fa: Fam:
Ernail: zarahjonesEyourcompanyemail com Ermail: zarat
User Defined: Usger Defined:

The 'Customer' tab shows you the name and address
information supplied with the order.

Change to the 'Line Items' tab. This shows you the items that
have been ordered.

Change to the 'Progress and Payments' tab. This shows you
the payment information entered at the store.

Now click the 'OK' button to close the order.

In the next chapter you will see how to process an order.

Exercise - Creating a Packing List

When you receive new orders, you can print a "packing list' for each
order, which can be used when making up the order, and also can be
used as a delivery note on the front of the package sent. This exercise will
show you how to print packing lists.

1.
2.

Go to 'Operations | Report Selection'.

Change to the 'Order Processing' tab.
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Reports, Expert and Mail 00 . -

Catalog | Order Processing | Sales | Export I E mail |
= Report of

Dutstanding Products Frarm:
Outztanding [nvoices e
Dutztanding Data Entry Reports L9
Dutztanding Credit Card Schedule
Qutztanding Preauthorized Schedule
R eprint Packing Lists
Feprint lnvoices
— e . - . — Ml e T

3. Select 'Outstanding Packing Lists'.

If you haven't placed any test orders, you might get a message box
popping up at this point telling you that there no outstanding reports to
be printed. You can still see the report, however, by right-clicking on an
order and selecting 'Reprint Standard Packing List Report'.

4. Click 'Preview'.

This will lay out the order information within a packing list report.

L-_:l SellerDeck Packing List Report

4 4 1 of1

b M m || 100% w| Totatl  100%

Sample Company

My Street
My Town
United Kingdaom

Phone: KMy Phone Number
Email: YourMame@Y ourCompanyEmail.com

Packing List =

|— Invoice Address:

More Information - Assurances

Orders are encrypted to two levels on the site. Any credit card
information is encrypted with a 1024-bit encryption key - which you can
view by going to 'Housekeeping | Security'. The name and address
information is then encrypted as well, but with a lighter level of
encryption as that information is less critical.

Orders are stored as files on the website with an extension of *.ord. Once
the order is fully downloaded into Sellerdeck Desktop, Sellerdeck
Desktop will send up a command to the web site to delete the order files
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on the site. This only happens once Sellerdeck Desktop is sure the order
has been safely received.
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Processing An Order

There is a set of order processing techniques built into Sellerdeck
Desktop. Some are optional, and some are required - i.e. Sellerdeck
Desktop will not consider an order as being 'complete' until you carry
them out. The required order processing steps are:

The lines of the order must all be marked as 'shipped' or
'cancelled'. This is shown below.

All payments for the order must be marked as being
'received'. This is also shown below. If you are using a PSP
(Payment Service Provider) the payment will be taken online
and so the payments will be marked as received before the
orders are downloaded into Sellerdeck Desktop.

An invoice must be printed for the order.

Alternatively if you don't want to process orders within Sellerdeck
Desktop then you can select the '‘Bypass Catalog Order Processing' option
in 'Business Settings | Order Processing’'.

Order Processing:
[7] Bypass Order Processing
[¥] Allow Back-ordering

This will mark the order lines as shipped and the payments as received
as soon as the orders are downloaded. You can then do one of the
following actions:

Print a 'Data Entry' report. This is a single piece of paper
containing every piece of information about an order. To
enable this feature, you need to select 'Enable Data Entry
Reports' in 'Business Settings | Order Processing'. To print a
data entry report, select 'Outstanding Data Entry Reports' in
the 'Order Processing' tab of the 'Operations | Report
Selection' window.

Export orders. This exports order information as a set of csv
spreadsheet files for importing into another application. This
is typically done in conjunction with 'Sellerdeck Link' -
Sellerdeck Desktop's accounts integration package. To enable
exports, select 'Enable Export to Files' in 'Business Settings |
Order Processing'. To carry out an export, go to 'Operations

| Outstanding Exports'.

Note: Because 'Bypass Catalog Order Processing' automatically marks
orders as shipped, if you delete an order, products in it will not be
returned to stock. You will need to adjust their stock levels manually.
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Exercise - Processing an Order

This exercise will show you how to use Sellerdeck Desktop's in-built
tools to complete a new order. This exercise is based around order
number 'DEMO0000000003' in the example Sellerdeck Desktop database,
but you could easily carry out these steps with any order.

1. Change to the 'Orders' tab (if you are not there already).

2. Double-click on order number 'DEMO0000000003' in the list.
3. Change to the 'Line Items' tab.
4

Highlight 'Diamond Pendant' and click the 'Ship' button,
clicking 'OK' to the message that appears.

Customer | Line ltems | Pick

Froduct Dezcription
|| Diamond Perndant

If the 'Ship' button is not available, it might be because you have selected
'Bypass Catalog Order Processing' in 'Business Settings | Order
Processing'.

5. Highlight the other products by holding down the 'Shift' key
and clicking each in turn.

6. Click the 'Ship' button to ship both.

Obviously if you have different order contents, then ship whatever order
lines are in the tab.

7. Click the 'Mail' button and click 'OK' on the warning
message that appears (once you are familiar with a
Sellerdeck Desktop message you can select the 'Don't show
this message again' box).

8. Select the 'Order Shipped...' email layout to generate a
confirmation email for the customer.

-
Mail

To sarahjones@yourcampanyemail com Lapout:

Order Receiver

EC: Paﬁment Recei
Subiject: User Definable
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9.

Click 'Done'.

You can view the email in the 'Mail' tab of the order. And send it by
going to 'Operations | Send Emails'.

10.
11.

12.

Change to the 'Payments' tab,.

On the ' Payments' tab you should see the demonstration
payment details. Click the 'View Payments' button.

Click 'New Entry' and then click 'OK".

Payment History for Order Mumber: DEMC0000000002

Payment kMethod

Date Status T ranzaction
2T02201310:3728 Received Chegue received
Datestime Created 2740242013 10:37:28 Fesults of Secu

Mode Praduction FPost/ip Code
Tupe b araal Address [AW5)
Status Faceived - Security Code [
Trangaction Cheque received 5 30 Fecure [Vb
Amount 2193 67] | | Emieled
CC Auth. Code Fresult
PSP Provider Bef Cae
Customer Fef
PSP Responze
Dateime Actioned 27022013 10:37:28

SellerDreck Payments

Cornrmit R efund Wioid Fay

This has made an entry in the payment history of the order saying that a
cheque has been received.

13.
14.

15.
16.

Click 'OK' to close the order.

Go to 'Operations | Report Selection' and make sure you are
on the 'Order Processing' tab.

Select 'Outstanding Invoices' and click 'Print'.

This will print the invoice to your printer.

The order should now have disappeared from the 'Orders' tab. You will
find it by going to the 'Completed' tab (change tabs at the bottom of the
window). The order is now marked as completed.
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Exercise - One-Click Order Processing

Rather than doing each step of the above exercise, it is possible to pre-
configure the things you want Sellerdeck Desktop to do to each order,
and then simply 'Complete' the orders with a single click. This is
described below.

1.
2.

Go to 'Business Settings | Order Processing'.

Select 'Enable One-Click Order Completion' (if it is not
selected already).

Select 'Print Packing List'.
Select 'Mark Packing List Printed'.

One-Click Order Completion

[¥] Enable One-Click Order Completion

Create Full Payment [¥] Prirt Packi

Ship All Lines [¥] Mark Pack

Print Data Entry Report Prirt Jnwviaid

Send Email [¥]  Mark Invoi
Click 'OK..

Now right-click on any order in the 'Pending' tab and select
'Complete Order'. Or highlight an order and click the
'Complete' button.

Order Mumber Jser

_| DEMO00000000m

B

_ | DEMOD0C View Order...
MNew Order
Delete
Back Order

Complete Order

Packing List

Invoice

The order should move to the 'Completed' tab.

More Information - Full Order Details

All the tabs within an order are described below:

Customer - This is where you can view and edit the
customer contact information.

Line Items - Use this tab to ship items, and cancel them. You
can also click the 'Add New Item' button to add a new
product to the order.

Shipping and Handling - For use if you want to change the
selected shipping method after receiving the order. Change
the shipping class in the 'Class' field at the bottom right, and
then click 'Update Order Shipping'. You can also manually
enter a shipping charge into the 'Calculated' field.

Taxes - View the tax charges on the order.
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Totals - For reviewing any changes you have made to the
order

Payments - This is where you enter/edit payment
information.

Progress - Where you can view the order status.

Misc. - This is where you can check any supplementary
information provided with the order such as purchase order
number, or answers to the 'General Information' questions in
the checkout.

Mail - View the emails generated regarding this order. You
can also send any pending emails, and generate new ones.

Journal - For making notes about the order.
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Stock Control

Sellerdeck Desktop includes a 'stock control' feature to monitor the stock
level of the products in your store and help prevent over-selling. The
stock level of a product is automatically reduced when an order for that
product is received.

NB If you have upgraded from Actinic v9 or earlier, you will need to
enable the real time stock control feature for your store. Go to the
'Options' tab in 'Settings | Business Settings' and tick 'Enable Online
Stock Control'. Then go to the 'Ordering' tab and tick 'Download Orders
and Refresh Stock Information Regularly' under 'Automatic Stock
Synchronisation'. You may also want to change the ‘Suspend If Below’
value to 0 (see below).

You can enter stock levels for products by going to the 'Stock' panel of a
product and filling in the 'Estimated Stock In Hand' field. You will also
need to make sure the 'Stock Control / Monitoring' checkbox is enabled
for each product.

(V] Stack Contral # Monitaring

E ztimated Stock |n Hand: 100

Warn I Belows: 0 Us

You can also get an overview of the stock levels of all the products in
your store by going to 'Operations | Stock Levels' or by clicking the &
icon on the toolbar. This allows you to quickly add/review stock levels in
Sellerdeck Desktop across a number of products.

@- Stock Levels

Select Product Type: All products Befrezh Proc

Brint Stack L

i

M ame tanitored?  Stock Warn below A

Three Diamond Ring v 100][5]
35
Solitaire Diamond Ring M aterial* ellow. . 10]([5]
Salitaire Diamond Ring M aterial wWhite .. 10([5]
Salitaire Diamond Ring M aterial wWhite .. 10][5]

Solitaire Diamond Ring M aterial * ellow. .

Salitaire Diamond Ring M aterial wWhite .. 91[5]
Salitaire Diamond Ring M aterial wWhite .. 101[5]
Salitaire Diamond Ring M aterial wWhite .. 91[58]

There are two stock warning levels for Sellerdeck Desktop:

o  Warn If Below - if the stock level of a product falls below
this level, you will receive a warning when you download
orders.
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e Suspend If Below - if the stock level of a product falls below
this level then the add to cart button will be replaced with an
'OUT OF STOCK' message.

You can set default values for these two stock warning levels in 'Business
Settings | Options'.

Default "Wam F Below™:

By default, Sellerdeck Desktop displays stock information for each
product on the web site. To disable this, go to 'Site Options' in the
'Settings' menu. In the 'Stock' tab, change 'Enable Display Of Stock
Information' to 'False'.

NB the stock level shown on the web site is the quantity for which
orders will be accepted. This is the actual stock level minus the ‘Suspend
Orders If Below” value plus one.

e To display actual stock levels and suspend ordering for a product
when its stock reaches zero, set ‘Suspend Orders If Below” to 0
(which falls back to Sellerdeck Desktop’s inbuilt default of 1), or 1.

e To allow customers to continue ordering after physical stock is
depleted, set ‘Suspend Orders If Below’.

If you just want to display an 'In Stock' message rather than actual stock
quantities, change 'Real-time Stock Display' to 'Display In Stock Message
Only'.

Enable Display Of Stock Information True
Real-time Stock Display Display In Stock
Uze Parent (=Dis

Note: Whenever you change any of the stock control settings, you need
to click the ‘Publish to Web” toolbar button to upload these changes to
the web site.

Exercise - Stock Control

This will simulate what happens when a product goes out of stock.

1. Go to your 'Golden Heart Necklace' product you created
earlier.

If you don't have this product, you can use any product.

2. Switch to the 'Stock' panel.

3. Tick 'Stock Control / Monitoring'.
4. Set the stock level at '20'.

5. Click 'Apply changes'.

This product is now stock controlled. If you place a test order for this
product the stock value will go down.

6. Now change the stock level to '0' and click 'Apply Changes'.
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7. You should find that the add to cart button has been replaced
with an 'Out Of Stock' message.

OUT OF STOC

A beautiful ems
one

Price: £102.00

Quantity: [

9. Change the 'Select Product Type' drop down to 'Ordering
Suspended' to see the product you have just put out of stock.

More Information - Stock Reports

There are a few reports available to help you monitor stock levels in your
store. If you go to 'Operations | Report Selection' there is a 'Catalog' tab
that features four 'Stock Level' reports. You can print these to help you
monitor the stock levels in your store.

Entering New Orders

As well as receiving orders from your online store, Sellerdeck Desktop
also allows you to enter orders straight into the program. This allows you
to also take orders over the phone or via fax, and keep all the order
information in one place.

Exercise - Adding a New Order Into Sellerdeck
Desktop

You can enter new orders into Sellerdeck Desktop using the 'New Order'
tab.

|Orders I 9B New Orderl |

To enter new orders into Sellerdeck Desktop using the 'New Order' tab,
you need to do the following:

1. Click the 'Search' button (in the Product Entry' box) to select
a product to add to the order.

Product Entry:

Ref Shay

Quantity: 1 update cart mp

If you know the reference of the product you want to add, you can just
type it in the 'Ref' field and click 'Show".
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2.

The product details will show up in the 'Selected Product'
area. You can select options and quantities and then click
'‘Update Cart'.

Then all you need to do is enter the name and address
information into the fields provided and select a shipping
method.

Once you've confirmed the cost of the order with the
customer (assuming you are taking this order over the
telephone) you can take the customers payment details and
then click the 'Confirm' button to add the order to the order
list in Sellerdeck Desktop.

Exercise - Editing An Existing Order

It is possible to edit an order to add new items. This exercise will show

you how.

1.
2.
3.

Double-click on an order in the 'Orders' tab.
Change to the 'Line Items' tab.
Click the 'Add New Item' button.

Click 'New', type 'sol' into the 'Select Product' field and click
'Solitaire Diamond Ring'. Click 'OK".

Click 'Next >' then click 'Next >' again and then click
'Confirm' to complete the addition.

Solitaire Diamond Ring should now be visible within the 'Line Items' tab.

More Information - Settings in Business Settings

If you go to the 'Order Processing' panel within 'Business Settings' you
will see there are few settings here under the heading of 'Offline Order

Processing'.

Offline Order Processing
[¥/] Enable Offline Ordering
[ Allow Uit Price Ovemide

Order Number Prefoc 0o

Select 'Allow Unit Price Override' if you want to be able to change the
price of items while you create new orders.

You can also choose a different prefix for the offline order numbers in the
'Order Number Prefix' field.
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Regular Customers

Using Sellerdeck Desktop, you can have accounts created for your
regular customers. This allows them to log into the store with a username
and password, have their name and address information preset in the
checkout, update their own contact details, and view current and past
orders.

You can also organise your customers into 'Customer Groups'. You can
then assign discounts to these customer groups and also hide products
from certain groups of customers.

Exercise - Creating Customer Accounts

This exercise will show you how to manage customer account creation
for all your customers.

1. Go to 'Settings | Business Settings' and click the 'Ordering'
tab.

2. Under 'Customer Login and Ordering', check the four radio
button selections and choose the one you want. The software
defaults to 'Create an Account Unless the Customer Chooses
Not To'.

3. Tick the box for 'Create Accounts from MOTO Orders from
New Customers'. This will create accounts for customers
who purchase offline, eg by telephone, as well as for those
who purchase online.

4. Select the 'Synchronisation' tab.

5. Tick the box 'Automatically Upload Customer Account
Changes' etc. This enables Sellerdeck Desktop to upload
customer account data in the background (and order data if
Order Tracking is enabled), without manual intervention.

P

Business Settings

E | M Automatic Synchronisation
C /Contact
i i [7] Automatically Download Orders, Upload Nev

%% Every 240 hiour(s)

-

Opti;ns Starting & 23:00:00 >

= [¥] Upload on Closing SellerDeck

6. Click 'OK..
From now on, an account will be created from each new order received,

provided an account does not already exist for the email address
supplied.

To view and edit customer accounts, select 'Customer Accounts' from the
'Operations' menu.
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Exercise - Creating An Account For
Customer

An Existing

Here you will create an account for an existing customer using the details

from one of their previous orders.

1. Go to 'Operations | Customer Accounts' and click the 'New

Customer' button.

2. Click 'Copy Details From Order Contact'.

Enter New Customer Details

Account Name:

M
Mame:

Cornpany Mame:
External Reference:
Main Contact
Salutation:
First Mame: *
Last Namg:x

M ame:

3. Select 'Sarah Jones' and click 'OK".

Account Addressesl Buyers
Custamer Group: Retail =
Payment Method:  Credit card details sent separately = Naotes

Copy Detals From 0
Telephone:

hd obile:

Faw

4. Inthe next dialog, type 'Sarah Jones' into the 'Name' field.

This creates a name for the account.
5. Now click on the 'Buyers' tab.
6. Click the 'New' button to create the login

details for this

customer. By default Sellerdeck Desktop uses the email
address for the Login. (Sellerdeck Desktop supports multiple
buyers for each account to accomodate business customers. If
you are selling to consumers, there will normally only be

one).

Enter New Customer Details

Account Mame: Sarah Jones

Addresses | Bupers |

o

ﬁ sarahjones@yourcompanyem. | Login:

Password: *

Confirm:

Salutation:

[ M I I BEemave l First Mame: *

[QDp_I,J Details From Order Cnntact...] Lesiae:

Mame:
Title:

Email:

* urcomparnyemail. com

Sarah
Jonez

Sarah Jornes

zarahjones@Eyourcompaye
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Create a password and enter it into the 'Password'and
'Confirm' fields. Note there is a button 'Send Password'
button for emailing the password to the customer. (When
accounts are created online, passwords are supplied by the
customers themselves).

Click 'OK".

More Information - Sophisticated Buyer Options

Go back to the account in Sellerdeck Desktop and look at the 'Buyers' tab.
There are quite a few useful options here:

Select 'Hide Retail Prices' if you only ever want this buyer to
see a single price (rather than 'Your Price' and 'Retail Price').

Select 'Allow User to Select or Enter a New Address' if you
want to allow your customers to enter their own new
addresses into the store, as well as using a saved address
online.

You can enter a 'Maximum Order Value' for this buyer if you
want to limit the amount they can spend on an order.

Exercise - Creating A Customer Group

You will now create a 'Trade' customer group, who will receive a 20%
discount when they log in.

9.

10.
11.

12.

13.
14.

Go to 'Marketing | Customer Groups' or click the & button
in the toolbar.

Click 'New' and enter a name of 'Trade'.

Highlight your Sarah Jones' account and use the '<' button to
move it to the left 'Associated Accounts' column.

-
Customer Groups

Customer Groups Accounts

Graoup Hame: Associated Accounts
Trade ?E!Sarah Jones

[ Hew ] [ Remove |
Retail

Click the 'Customer Pricing' button, and click 'OK' on the
window that appears.

Highlight 'Trade' in the list and select 'Multiply By'.

In the field enter '0.8' and click 'OK". This will give a 20%
discount.
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Price Schedule

Base Schedule: Retail

a1 b iche Bhy 0 ony

Now upload the store and log in to test the discount for 'Trade'
customers. You should see both a 'Retail Price' and a 'Your Price'
appearing in the store.

Order Tracking & Order History

Using Sellerdeck Desktop you can allow customers to follow the progress
of their orders automatically online. If you have Customer Accounts
enabled, they can also view a limited number of past orders via their
online account page.

To enable this feature:

1. Go to 'Settings | Business Settings' and select the 'Online
Order Tracking' tab.

2. Tick the first two boxes.

3. If you tick Include Orders From Registered Customers', then
account customers will be able to view past and present
orders via their online account page:

Buyer: Sarah Jones | Account: Sarah Jones | My Account | Logout

My Account

Change password

Account details

Sarah Jones ¢
01234 567390

Billing address

Anywhere
Anytown

AMY 123 :
United Kingdom

Recent Orders
(Flease note that recent orders may not appear immediately!)

ma

DOOOOO00000000  27/02/2013 £31.52 Awaitinn Pavment

4. If you tick 'Include Orders From Unregistered Customers',
then all customers will be able to track orders by searching
on the order number and postcode.

For information about the other settings in this tab, see the main help
(Help Topics' in the 'Help' menu).
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Designing Your Store

Please note that the following features are not available in 'Client'
versions of Sellerdeck Desktop.

Choosing A Theme

A theme is a quick way to give your store a new look and feel. It is worth
experimenting with the themes that are available so you can find one you
like - and then use it as a starting point for any further changes.

Exercise - Changing Theme and Colour Scheme

This exercise will just use simple settings to change the look and feel of
your store.

1. Go to 'Design | Themes'.
2. Inthe 'Themes' list, change it to 'Vanguard'.

-
Themes

Theme

Clazzic Responzive I

Responsive Wireframe
Smart Responsive

Cilor

Purple -

Reggae
Rufus '
3. Inthe'Color' list, select 'Pinkerton'.

4. Click 'OK".
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%) Business Plus - Online Catalogue

. Ele Edit Settings Design Qperations Marketing Web Housekeeping Window Help

& By 0] 9 - @ <] £ Business Settings [ Sie Options [ . O Retrieve Orders B & Reports 5 | 8 & . () & -2
0] 10 Preview Store 3 Publish to Web o _ :
R Content |[&F Design | B Orders | & New Order | &5+ Services |

Content Tree [Page Preview

-[E] More Pages -

=-§> Online Catalogue -

L. © My Phone Number @ o

-§) Wedding Rings
& Solitaire Diamon

Solitaire Diarmy

% Solitaire Diamy
% Solitaire Diam -
% Solitaire Diamy
ecommerce

Solitaire Diarmy

Solitaire Diamy
Solitaire Diamd =

Solitaire Diamy

Slitaire Diamq
Solitaire Diamg Quick Search

Solitaire Diarmy

I SHGHGHESHB55 S

Solitaire Diamy

This has now applied a new look and feel to your store, but you can
change each individual element at a much more granular level.

For example you can tweak the colours used in the design by going to
'Design | Themes' and clicking the 'Advanced Themes Configuration'
button. Then change to the 'Color Schemes' tab.

-

Themes
Color Scheme Page Laynutg
Evergreen - Background: i} * Se
Fresh ; —
Glare | Test . +* En
Golden - Reguired Field: K -~ Fs
Kazzam T

Moon Phaze Link: m v| FPa
Hocturne Wizited Link: [ ~ Fa

Drange Spice

Pkeron—— [INECUC ) R
Purnla touse Hover Link: m -

Form Background: EEEEEE

4

Form Emphasziz; faF3r3 -

You can tweak the colours and then save your colours as a new colour
scheme.
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Adding Custom Fields

Sellerdeck Desktop allows you to create any number of custom settings
for the items in your content tree. Examples of this include an 'Artist'
field for CDs, a 'Starring' field for DVDs, or an 'Author' field for books.
These custom settings are referred to within Sellerdeck Desktop as 'User-
Definable Variables', and they appear within grids like this:

= Site
Cart Price Description

Company Logo Image
Encbor Towk

Price:

theme_corporate |

You can include these custom values into your store designs by inserting
the variable into the layouts, as discussed in "Help With Design" on page

86.

Exercise - Creating a New Variable

1. To create a new variable, go to 'Design | Library' (or click the
(& button) and then change to the 'Variables' tab.

&) Design Library

2 [t |

popup me:

Select the appropriate item in the tree, then right dick and choose what you want to do from the

nu

Variables | Conditions

= Library

i3 Appearance Settings
i3 Attribute

{3 Best Sellers List
-3 Brochure

..... @ Checkout

{8 Choice

..... B Component

7B Design Wizard
{-R Facebook

{3 Feefo

----- @ Filters

{8 Fragment

{3 General

i@ Google Plus

{8 Mega Menu Variables
{8 Mavigation Images
{8 Mew Order Form
H-8 Mew Products List
{3 Other

iR PayPal

----- (R Permutation

iR Pinterest

{3 Product

1A ReCAPTCHA

m

N

2. Right-click on Product' in the tree and select 'New Variable'.
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Add New Variable -

=" !

Bazic: Definition | Values | &dvanced Place of Settingl

Marne:

Description:

Prormpt:

Group: Product

Place Of Setting
[ 5ite

[T] Section

[T] Brochure
[7] Product

[] Eragment

Type: Text
Allow Empty Value

Fanel Mame:  Froperties

[7] Component Allow <L
[ Atribute Bllaw <M
[7] Chaice

[T Permutation

Searchable [Site, Section and Product variables only)

3. Inthe'Name' field, enter 'Manufacturer'.

4. Inthe 'Description' field enter 'New field for the

manufacturer of the product'.

5. In the 'Prompt' field enter 'Enter Manufacturer's Name'.

6. Under 'Place Of Setting' select 'Product'.

This means that the new field will appear for your products.

7. De-select 'Allow <Use Parent> as an Option'.
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Edit Variable - Manufacturer e
B asic Definition | Walues | Advanced Place of Setting
Mame: b anufacturer
Description:  Mew field for the manufacturer of the product
Prompt: Enter Manufacturer's Hame
Group: Product i
Place Of Setting
[ 5ite [7] Component [] &llows <0
[7] Section [ Atribute Alla <M
i [7] Brachure [7] Chaice
Product [] Permutation
[] Eragment
Fanel Mame:  Properties -
Type: Text -
[¥] llaws E mpty alue
[] 5earchable [Site, Section and Product variables anly)

8. Click 'OK' and the 'OK' again to close the library.

You can now change to the Content tab in Sellerdeck Desktop and enter

the manufacturer’s name for the rings. You will find the new field within
the 'Properties' panel.

= Product

Later on in this guide, you'll see how to insert these values into the
design.
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Choosing Alternative Layouts

It is possible to select different layouts for every single item you see in
the content tree. This is done by going to the Layout' panel of the item in
question, and selecting an alternative layout.

Very often a setting will have the words 'Use Parent' in it.

Product Layout (Responsive) Use Parent (=Regular Product Summary)

'Use Parent' simply means that the value for this setting is set somewhere
'higher' up the Sellerdeck Desktop structure. If you click on a setting it
will usually tell you where the value has been set in the area underneath
the grid of settings.

Product Layout

Layout for your products
Current value is "Reaular Product Summary” inherited from vanable

Note: When it says the value is coming from the 'Variable Definition' it
just means that the 'Top Level Value' for that variable is set in the library.

Exercise - Changing Layouts

This exercise will show you a selection of changes you can make within
Sellerdeck Desktop. To begin with, you will change the way your
products appear:

1. Go to 'Settings | Site Options' and change to the 'Layout'

panel.
Site Cptions
General
e
Lk Checkout Pages Layout Responsi
Extended Information Embedded Preview Compatibility IE=10
Design Wizard Footer Layout: Deep Foo
Product Page Login Page Layout Responsi
MegaMenu MNavigation Bar Layout Main Mei
Fropeties PSP Bounce Page Layout Responsi
Fittering Product Alse Bought List Layout Regular 2
Page Settings Product Related Products List Layout Compact
Shopping Cart Shopping Cart Summary Layout Shopping
Social Media Sidebar Layout Regular L
Stock Top Level Section List Layout Plain Top
Marketing View Cart Page Layout Responsi
= Section
Bottern Parent Section List Layout Use Parer
Bottem Sub Section List Layout Use Parer
Column Count For First Row Of Section Lists Use Parer

2. Locate the Product' heading, and within that, find the
'Product Layout' setting.

3. Change it to 'Classic Product Layout'.

Product Image Layout Standard Product Image 3
Product Layout (Respensive) Image On Left Text Wrapped Around =L
Product List Layout Use Parent (=Regular Preduct Summary)

Product Related Products Item Layout Compact Product Layout
Width Of Product List m age On Left Text Wrapped Around

Image On Right Text Wrapped Around

= r

4. Now locate the 'Column Count For Products' setting and
change it from 'Use Parent (=1)' to '2".
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= Product
Column Count Far Pradurts 2

5. Click 'OK' and then look at one of your sections to see the
change.

Rings

Three
(;: > D_iamond
— Ring e@
' 100 in stock. =

Perfect white gold
ring for engagement or eternity. Rings come ag

Price: £24.00 (Induding VAT af 20%) Price: £156.00

Quantity: 1 Quantity:

As well as setting default values for the entire store in 'Site Options', you
can override settings at the section level and at the product level.

1. In the content tree, change to the 'Rings' section.
2. Go to the 'Layout' panel of this section.

3. Click on the 'Column Count For Products' field. It says 'Use
Parent (=2)' Notice at the bottom of the panel it is telling you
that the value has been set in 'Settings | Site Options'.

| columin Count For Products

The number of columns in a list of products
Current walue is "2" inherited from Settings | Sike Options

4. Change the 'Column Count For Products' from 'Use Parent
(=2)'to 1.

5. Change the 'Product Layout' to 'Image On Right Text
Wrapped Around'.

6. Click 'Apply changes' to see the difference in the preview.

Rings

Three Diamond Ring
[ 100 in stock.

Perfect white gold ring for engagement or eternity.

Price: £24.00 (Induding VAT at 20%)

It's possible to change the layout and column count for many different
items in the store, such as attributes:
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1. Select the 'Wedding Rings' product.

2. Select the 'Men's Size' attribute (within the 'Option’
component).

£-§) Wedding

-

3. View the attribute's details and change to the 'Layout' panel.

4. Change the 'Column Count For Radio Buttons' from 'Use
Parent (=1)' to '3".

5. Do the same for the 'Women's Size' attribute.

6. Click 'Apply changes' and check the preview. The radio
buttons should now be in three columns.

Men's Size Womens

@P ®Q @R @ 1

s T @ U L
W W B W 0

More Information - Layout Selectors

The layout selection drop-down lists in Sellerdeck Desktop are all
controlled by things called 'Layout Selectors'. It is possible to edit the
layout selectors in Sellerdeck Desktop to change the order of layouts that
are offered in the drop-down list, remove layouts and even add your
own custom layouts.

There is more information on this in "Inserting Layouts" on page 92.
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The Design Tab

The 'Design' tab is used to change the look and feel of specific elements of
your page design.

(&) Business Plus - Online Catalogue

File Edit Settings Design Operations Marketing Web Housekeeping Window Help

ok U (7| 9« @ | ) Business Settings [5 Site Options [ . @ Retrieve Orders 8 SiReports 'y @ | § & . [ &I e 7
£ |0 Preview Store & Publish to Web o/ _
B3 Cortert| [ Desion | @ Orders | 4 New Order | £ Services |

] plit View [] Design View [<=| Cade View | Select Page Type Cantent Page | = | Click here to sec crrors | Cumrent Styleshest

Page Preview

(tli]e]+]

A vome & oG -@ VEWCART B

CHECKOUT

s m a rt | Terms & Conds | Login | ¢

Quick Search

Rings Necklaces Bracelets Earrings Wedding Jewellery Mens Best Sellers

It has two main areas:

o Interactive Preview - - Click on anything in the
preview and a dotted line will appear around it. If a piece of
text is selected, you will be able to change the appearance of
it with the formatting controls in the toolbar above the
interactive preview (e.g. bold, italic, colour etc.).

Also, the HTML that lays out the part of the page you have
selected will appear in the 'Layout Code' panel.

= :
¢ Layout Code - - This shows you the code of

whatever you have clicked on in the preview. You can edit
the code here and click 'Apply’ to see the effect on the
preview.

At the bottom of the Design tab are three main tabs where you can
change between the Page Preview tab, the Layout Code tab and the
Details tab (where you can edit names, descriptions, etc.)

|| [£] Section Details - Rings| [&. Page Preview | (@) Layout Code - Full Width Header And Two 5fdebars| |

You can also click the button to see the preview and the

layout code at the same time.

Down the right-hand side of the Design tab is a narrow vertical panel
that either contains the Content Tree or the 'Design Tree' - depending on
what tab is chosen at the bottom of the panel. The Content Tree allows
you to quickly change the section you are viewing in the Design tab. The
Design Tree shows you all the layouts that make up the current page.

If you want to select a section to edit, use the Content Tree. If you want to
edit a page that isn't a section (including email and style sheet layouts)
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then use the 'Select Page Type' drop down at the top left of the Design
tab.

? Services

Page Type | Content Page B Click here to see errors | (]

Content Page

Site Map

Terms And Conditions
Contact Us

Search

Search Results

Login
Signature
Add Te Cart Confirmation

Shopping Cart
Checkout Page 0
Checkout Page 1

Exercise - Changing Fonts

This exercise will show you how to use the Design tab to change the
appearance of the text in your store.

1. Expand the 'Rings' section in the Content Tree and select the
'Three Diamond Ring' product.

2. Click on the 'Three Diamond Ring' product name in the
preview.

3. If a message dialog appears just click 'OK'. Hint: you can tick
'Do not show this warning in future' if you want to stop it
appearing again.

4. Click on the L icon in the preview toolbar to make the
product name italicised.

Three Diamond Ring

You can do this kind of text formatting for any text in the store.

5. Now click the 'Undo' icon on the toolbar - 2
6. This should reverse out the font style change.
7. Now select a different style.

Notice that the change you made changed all the products on the page -
this is because they are all using the same layout. It will also change the
appearance of products in other sections in your store.

More Information - Working With Dreamweaver

Sellerdeck Desktop comes with a Dreamweaver extension that allows
you to supply a totally custom overall layout to Sellerdeck Desktop, and
also edit layouts using Dreamweaver. For more details on this, see the
section in the main Sellerdeck Desktop help called 'Working With
Dreamweaver'.
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Help With Design

Designing in Sellerdeck Desktop can take a little while to understand -
this is just because there aren't that many programs that work in the way
Sellerdeck Desktop does. However, once you've learnt the basics, you
will discover how flexible Sellerdeck Desktop is to design with.

The important thing is to spend a bit of time trying to understand how
the various features work, before ploughing ahead and trying to make a
specific change.

These articles will lead you through the essential things you need to
know.

Using the Preview to Select a Layout
Try clicking within the preview panel in the Design tab.

i3 1 CIEY
[l uPa LN F-!

You should see a dotted line appearing round the thing you've clicked
on. This means you've selected a layout (or an item within a layout).

Layouts are the building blocks of Sellerdeck Desktop pages. They are
pieces of HTML that Sellerdeck Desktop sticks together in order to create
each page in the store.

It is possible to see the HTML code of the layout you've clicked on. To do
this, look at the 'Layout Code' panel. This will either be underneath the
preview, or it will be on a separate tab.

Layout Code - Responsive Cuter Layout

meaQ xppmplaR

<ldoctype html>

<html>

<head>
<title>PageTitle</title>
MetaTags

o L n =

T Y O L % R

In the title bar of the Layout Code panel is the name of the layout.

ﬂ (@) Layout Code - Responsive Outer Layout ”

Make a mental note of this, as it's useful to know what the layout is called
in case you ever need to go back to it.

Note: The I button on the layout code toolbar is used to toggle between
an 'advanced' and 'simple' view of the layout code. You generally just
leave it on the 'simple' view.

Navigating Round the Layouts

Once you have selected a layout in the Design tab, look at the layout
breadcrumb trail that runs along the bottom of the Design tab.

86 e Designing Your Store

Getting Started Guide



| & Responsive Outer Layout > @ Product Page Body RWD > (B Image On Left Text Wrapped Around > (B Standard Product Image |

The breadcrumb trail shows you that the layout you've clicked on is
located within another layout 'above' it, and that layout in turn is located
within another layout. So in the example above, the product layout is
located within the product list, which in turn is located within the
'section page' layout - and so on until you reach the 'top' of the design,
which is a special layout called the 'Overall Layout' (also known as the
'Outer Layout').

If you only see one layout in the breadcrumb trail, it's probably because
you've already got the Overall Layout selected in the preview.

You can click on the layouts in the breadcrumb trail to select them, and
this way you can move up in the design.

You can also click the & button on the layout code toolbar and the
icon in the preview to move up a level in the design.

The down arrows are for taking you back to the layout you were on
previously.

You can see the full structure of the layouts used to build the page by
viewing the 'Design Tree'. To see the tree, click on the tab at the bottom
right of the screen.

|De5ign Tree

a @

=4 Responsive Quter Layout

-y Standard Meta Tags

' Default Base Href

- Standard Javascript Header Funct
' Standard Social Media Functions
-4 Full Subheader

Eg..-' Regular Header Area

4 Smart Mini Menu

E:.I"" Main Menu Bar

-4 Regular Left Sidebar

- B2B Links

-4 Section Page Body

IF-JE Compact Parent Section List

------ B Responsive Section Fragment

EE Fesponsive Product List

=l

Page Structure
All Sellerdeck Desktop pages are divided into two parts - the 'outer' and
the 'inner'.

o The 'outer' part of the page controls the branding and
navigation elements that largely stay the same as you go
from page to page. They are the elements that usually go
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across the top and down the side of each page. The outer
part of the page also contains the <head> section.

o The 'inner' part of the page controls the content for that page
- so if it's a section page it will be the section links and
products, and if it's a checkout page it will be the checkout
fields etc.

Outer Layout

The outer part of the page is controlled by a layout called the 'Overall
Layout' (also known as the 'Outer Layout'). This is the 'top' layout of each
page - which every other layout is inserted within.

Outer layouts always contain a pink/purple placeholder called
INNERLAYOUT, which will be replaced by the content (inner layout)
for that page when the page is generated.

You can select the overall layout within the Design tab by clicking
anywhere within the preview, and then clicking the first layout on the
layout breadcrumb trail.

| & Responsive Outer Layout > @ Section Page Body > H Responsive Product List > & Image On Right Text Wrapped Around |

Alternatively, you can view the Design Tree and then click on the top
item in the tree to select the overall layout.

|Design Tree

@
El. Responsive Outer Layout

@ sStandard Meta Tags
A Default Base Href

Inner Layout

The inner layout is harder to talk about as it will be different depending
on which page you are looking at.

For section pages, the inner layout will probably have a name that starts
within 'Section Page...' and when you look in the code of it, you'll see lots
of references to 'section lists' and 'product lists'.

Layout Code - Section Page Body
Haeae@ i mpompm e
29
30 Message for Unredgis
31
32 block if
33 block if
54 <div class="H
S ParentSect
36 <fdiv>
37 /block
38 SectionNane
39 /block
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Every 'type' of page has a different inner layout that controls the layout
of its content. All the inner layouts used by the store are collected
together in the library in a group called 'Web Page Inner Layout'.

mﬁ Wariant Selectors
=% -] Web Page Inner Layc
. Best Sellers Page

) Bounce Page Bul

- BouncePagelnne

s @ Brochure Page By

Editing and Undoing

You can make a change to the HTML of a layout and then click the
'Apply' button to see what effect this has on the store.

Armmlie

The preview will be automatically updated when you click 'Apply'.

If you are not happy with the results, click the 'Undo' button on the
toolbar to undo the change - il

You can also edit layouts using Dreamweaver. This is described in the
main help in a section called 'Working With Dreamweaver'.

Remember when making changes that this layout is probably going to be
inserted within another layout, so be careful when making changes that
you don't do anything that might distort or corrupt this 'parent' layout.

If you have made a mistake with a layout, and you cannot work out how
to get the layout working again then you can always revert the layout
back to its 'factory settings'. This is described in the next section.

The Library

The Design tab allows you to edit the layouts that are used within a page,
but the Library allows you to search through and edit all the layouts
within Sellerdeck Desktop.

You can open the library by going to 'Design | Library', then change to
the 'Layouts' tab.

Highlighting the layouts you've edited

If you click the 'Highlight edited library layouts (*)' checkbox at the
bottom of the 'Layouts' tab, you will highlight any layouts you've
customised, and new layouts you've created.

Layouts you've customised will be marked with a (*) and have a @ icon.

You can also highlight any new layouts you've added by selecting the
'Highlight new user layouts (+)' checkbox.

Searching for layouts

Right-click anywhere within the Layouts tab and select 'Find'.
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Find In Design

Searchfor Text:  ProductMame

In: MName Description Prompt [

Find Mext tem Find Mext in Code

You can search for the name of a layout or some code within a layout.

Creating new layouts

Right-click on a layout and select 'New Layout'.

-

Mew Layout
Layout Mame: | & g appe
Based On: Image On Right Text Wra|

Give the layout a name and click 'OK'.

Note: You can also create new layouts within the Layouts tab of a
product/section/Site Options. Simply select the '<New>' option at the
bottom of the drop down lists.

Product Layout (Responsive) Use Parent (=Image On Right Text Wrapped AroundjE]f
= Component | Use Parent (=Image On Right Text Wiapped Around) __|
Component List Layout Compact Product Layout
= Attribute Image On Left Text Wrapped Arcund

Irmage On Right Text Wrapped Arcund
Regular Praduct Sumrmary
<Mews

Column Count For Attributes
= Other

Deleting layouts

You can only delete a layout from the library if it's a custom layout that
you've created, and you haven't selected it anywhere.

Reverting to Factory Settings

If you have made a mistake in a layout, and you want to put it back to
how it was before you started making changes to it, then you can right-
click on it in the library and select 'Revert to Factory Settings'.

- Products
..... l Y Compact Pty
_____ @ Filtered Pr New Layout Type
----- ©) FilteredPro New Selector
""" z Image On Mew Layout
----- Image On
----- ®)] Proc?uctLa F‘\r:.namr:
----- © Productla B
..... © ProductPa Find
----- © ProductPa Copy
""" @ Regular Pr Variables Tab
[]---ﬁ Promotional L
[]---ﬁ Prometional L Delete
uick Search B
gg RQeaI TirmaSto Revert To Factory Settings
EJ---ﬁ ReCAPTCHA Compare With Previous Version
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Layout selectors

Layouts are only part of the picture. There are also round things called

'Layout Selectors' - @ - that control how layouts are listed within the
'Layout' panels.

Product Layout (Responsive) Compact Product Layout =

= Component Use Parent (=Image On Right Text Wrapped Around) |
Component List Layout Com pact Product Layout |

| : Image On Left Text Wrapped Around |

|= Attribut:

I - In i P e Image On Right Text Wrapped Around

You can edit these layout selectors to change which layouts are listed
within Sellerdeck Desktop, and in what order.

Inserting Variables

Variables are placeholders for Sellerdeck Desktop data. When the pages
are generated, the variables are replaced by real data.

Variables in layouts look like this:

ProductHame

Inserting a new variable is simple. Let's say you wanted to add a new
link to your home page. To do this, you might add the following HTML
into the layouts:

<a href=""=Click here to go to the home page<fa>

You can now place your cursor between the two quote marks and click
the 'Insert Variable' button - &
The list of layouts is initially really long, but you can use the 'List names

containing' filter the search. If you enter 'Home' into the list, the list
becomes:

@ Insert Variable

MName

CatalogHomeURL

Home

HomelconImage

HomelconImageHighlight

HomePageType

HomeText ’
S5LCatalogHomeURL

You can now highlight 'HomePageURL' and click 'Insert'.

<a href="HomePageURL">Click here to go to the home page<jfa>
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Exercise - Including the ‘'Manufacturer’ Variable
into the Design

Earlier on in this guide, you created a new 'Manufacturer' variable. This
exercise will show you how to include it in the design.

1.

Go to the Design tab and then make sure you are looking at
the 'Rings' section.

Click on the name of one of the products on this page. This
should highlight the 'ProductName' variable.

Add in a new blank line straight after the variable.
In the new line, type by’ followed by a space

Right-click at the end of the line and select 'Insert Variable'.

QQQ In mo R
40 ProductHame
41
42 H Insert Variable...
43 Insert Layout...
44 ¥

| Insert Block
45 H
46 [ Insert Inner Page
47 A Insert File Marme
48 d
23 [H H Look Up In Styles
50
- Undo
52 Find...
S5 o

Select 'Manufacturer' from the list of variables that appears
and click 'Insert'.

Click 'Apply' and check the preview to see if your value has
appeared.

Three Diamon

If the value has not appeared for all your products, it may be because
some are using different layouts. You may need to insert the
Manufacturer in more than one layout.

Inserting Layouts

To insert a layout, use the @ button on the layout code toolbar.
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Insert Layout

Layout Selectors
—_—
-

AdministratorEmaillayout (il
All Countries List o
AllCountriesList

Attributelayout

AttributeList

BaseHref

BestSellerltem
BestSellerListsidebar
BestSellersList
BouncePagelnnerLayout
BrochureFragmentlist
BrochureInnerLayout -

List names containing in Class

[] Use Fixed Layout

What you get presented with though is not a list of layouts - rather, you
get a list of Layout Selectors (which you might have seen within the
Library).

The job of a layout selector is to insert a type of layout into the design.
You can see these layout types in the 'Layouts' tab of the library.

=-J Library
=@ Add To Cart Butt
- .4 Add To Cart §
@ Add To Cart §

For example, inserting the 'ProductLayout' layout selector will insert a
product layout into the design, and the 'AddToCartButton' layout
selector will insert an add to cart button into the design. The actual
layout that is used is controlled elsewhere - usually in Site Options.

= Product
Add To Cart Button Layout Use Parent (=Ad,
Cart Button Image Use Parent (=Ad
B wm 4 s A T Cark Do

If there is a specific layout that you know you want to insert, rather than
just inserting any layout of a particular type, then you can select the 'Use
Fixed Layout' button and select one from the list.

Add To Cart Button Ima

Warning - using 'Fixed Layouts' means that you will no longer be able to
change the layout in Site Options or in the Layout panel of your
sections/ products. More details are in "Advanced: Fixed Layouts vs.
Selectable Layouts" on page 95.
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Hiding Things With Conditions

When you look in layouts, you see lots of green 'block if' tags.

block if

£

Manufac

These are conditions, which will hide the text between the block tags
unless a certain condition is met. You can view and edit the condition by
double-clicking on the opening 'block if' tag.

[& condition Editor

G& @ @Insert an operator into expression -

Manufacturer != "7

In the above example, the text shown is hidden unless the 'Manufacturer
field has a value. If the 'Manufacturer' setting doesn't have a value, then
the whole thing is hidden.

Using Stylesheets

Sellerdeck Desktop makes use of stylesheets to control layout and fonts
in the store. If you want to change the layout of items on a page, or the
default appearance of text, you will probably have to think about editing
the main Sellerdeck Desktop stylesheet.

Note: You can edit the default font size and appearance in the 'General'
panel of 'Site Options', and you can edit colours in the 'Color Schemes'
tab of 'Design | Themes'.

Whenever you see a style used in Sellerdeck Desktop layout e.g.:
<div clazs="header-arsa'>

... you can right-click on the style and select 'Look Up In Stylesheet'.
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-
Edit Layout Code - Elegance Stylesheet
MeeG kmpmmk R
a2 .header—-area f{
63 background: Palette? url ("header-backgr
64 color: Palettel:;
(3= padding: 10px;
66 width: blockecho (WebPageCverallWidth -
a7 }
(=3 .navigation-bar {
&9 width: blockecho (WebPageCverallWidch):
70 z-index: 99999%;
7. background: PaletteBG url ("nav-bar-bg.g
T2 padding: 0 10p=x:
T3 }
T4 .bulk-area {

You can then edit the style as required.

The layout that controls the stylesheet is the 'Current Stylesheet'. You can
also open it from the 'Select Page Type' drop down list in the 'Design' tab,
or just by clicking the 'Current Stylesheet' button on the toolbar.

Select Page Type Content Page B Click here to see errors |

Checkout Page 0 -
Checkout Page 1 H
Checkout Page 2
Receipt _
Bounce Page

Overwrite Saved Cart Confirmation Page !E
Cunenspicsheer = I8
Digital Download Folder Index Page

Terms And Conditicns Popup
J PSP Bounce Page
Paypal Pra Confirm Order Page
MOTO Ferm >

Note: In the Library, you'll find the current stylesheet layout within the
'Web Page Outer Layout' group.

You can use your own styles with Sellerdeck Desktop. Either just add
them to the bottom of the current stylesheet layout, or save your
stylesheet within the Sellerdeck Desktop site folder and then use a tag
similar to the following to add link your stylesheet in.

fhlock
<link href="actinic.css™ rel="astvleshest™ type=

<link href="mv-custom—-stvies.css" rel="sitvleske

This tag needs to go in the <head> section in the overall layout used by
the site.

If you right-click on an HTML tag in your layout that is using a tag from
your custom stylesheet, and then select 'Look Up In Stylesheet!,
Sellerdeck Desktop will open up your custom css file in your default CSS
editor.

Advanced: Fixed Layouts vs. Selectable Layouts

In the section called "Inserting Layouts" on page 92 it talks about how
when you insert a layout selector, you have a choice.
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* You can insert a layout selector into the design, without
specifying a specific layout - this is also known as using a
Layout Placeholder

AddToCartButton

e Alternatively, you can select a specific layout to insert into
the design - this is known as a Fixed Layout
Add To Cart Button Image

Using Layout Placeholders

When you insert a layout placeholder (rather than a fixed layout) it will
insert a type of layout into the design. You can generally choose the
layout to be inserted within the 'Layout' panel of 'Settings | Site Options'.

= Product
Add Te Cart Button Layout Use Parent (=Ad,
Cart Button Irage Use Parent (=Ad
me nn 0 .a Arded T Cart B

You can then often override this setting within the Layout panel of a
section, or of a product.

Not all layout selectors have a place of setting in Site Options. If you find
one that doesn't, then you need to go to the 'Layouts' tab of 'Design |
Library', and edit the layout selector there.

Initial Value
Top Level Value

Edit the 'Top Level Value' there in order to change the layout that will be
inserted.

Fixed Layouts

When you insert a fixed layout, it effectively disables the layout selection
options in 'Settings | Site Options'. The choice of layouts is still there, but
they will be ignored when the pages are built.

To change a fixed layout into a layout placeholder, you can right-click on
the pink layout name in layout code and select 'Edit Appearance'.

= Product
Use Fixed Layout Add To Cart
=l Site Mo ()

In the screen that appears, set the 'Use Fixed Layout' option to 'No()' and
click 'OK".

Advanced: Editing Lists

As well as standard layouts, you will sometimes come across things
called lists. They look like this in the layout breadcrumb trail:

Page Body > EH Responsive Product List > {8 Compact Product Layout

Lists always have an orange link across the top of the layout code that
says 'Click here to edit list layout settings":
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Lists work differently to other layouts. Their job is to insert a set of items
into a page. Wherever you see a list of products, or a list of sub-sections,
or a list of best sellers, or a list of locations, somewhere in there a list will
be controlling the placement of the items.

Editing the list allows you to edit the HTML that goes at the start of a list
of items, at the end of a list of items and around each individual item.

To edit a list, click the orange 'Click here to edit list layout settings' text at
the top of the layout, or click the 'Edit List Layout Settings' button.

f&) List Layout Settings

{ Uveral Design | Edit Fows and Columng

Start of List: <div class="product-list actinic: block if=""%3cactinic 3avaniable320r

End of List: <A

Empty Lizt Entry:

Ernphy List:

Use Different HTML when there is only orne item [

Befare Single [bem:

The 'Start of List' and 'End of List' fields here are self explanatory. It gets
a bit trickier in the 'Edit Rows/Columns' tab:

f&) List Layout Settings

Owerall Design | Edit Rows and Columns |
| Fist/Middle/Last | Ddd/Even|

Moofltems  Before Row Firzt [tem Middle [tems
Before After Befare After

Fist Fow — [Notllsed
Middle Rows | Dynamic <divcl., |<idive  [<divel. |</dive
Last Row Mok Uzed

Don't panic! This screen looks more complicated than it is. This is where
you can control the code that goes before and after each item in the list.
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Generally, you only have to worry about the 'Middle Rows'. Only use the
'First Row' and 'Last Row' settings if you want the first or last row to be
different to the other rows. The 'No of items' is where you can set the
number of columns in your list - but this only works if your list is a table.
Otherwise, just leave this set to 'Dynamic'. If you see a variable within
this field, it means you can set the number of columns in the 'Layout' tab
of the section/product you are currently editing.

Also, there are three sets of 'Before' and 'After' fields just in case you have
multiple columns in your list and you want the columns to look different
from each other. Most of the time you can just put the same code into
each set of fields.
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Sellerdeck Enterprise

Introduction

Sellerdeck Enterprise has been specifically designed for medium-sized
businesses with higher order volumes. In addition to the functionality of
Sellerdeck Business, it also offers:

e A scaleable SQL database option to replace the standard Access
database. The database can reside on a local network or remote
server, and provides a much higher capacity particularly for
storing large volumes of orders.

e  Multi-user access with control over user access rights.

e The ability to create and manage multiple ecommerce sites.
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Setting up Sellerdeck Enterprise with a SQL database

To create sites using a SQL database, select ‘Sites’ from the Sellerdeck
Enterprise ‘File’ menu and click the “Database Setup’ button. This will
open the ‘SQL Server Administration” dialog.

SQL Server Administration Details -

Server details:

@ Default () Site S

Server details:

SOL Server: QLSERVE

Server Administrator User Details

@ Database User (71 Windov
Administrator Username: 53
Administrator Password: —

Enter the path to the SQL server, e.g. ' MYSERVER\SQLSERVERNAME’
without the “. Local paths must not be used. If the server uses ‘SQL
Server Authentication” select “Database User” and supply the
‘Administrator Username” and ‘Administrator Password” of the SQL
server you wish to create your database on. Alternatively, if the server
uses “Windows Authentication” select “Windows User’.

Enter the UNC path to the shared sites folder where you would like your
backup do be.

Click ‘OK’ when done.

If you are not sure of the settings for your particular server, contact your
SQL server administrator for assistance.

The server specified here will be default server for the location of your
Sellerdeck Enterprise site databases.

Licensing a Site that uses a SQL Database using
the Default SQL Server

Click the ‘Licence New Site” button and select “‘MS SQL Server’. The
‘Create New SQL Site” dialogue will be displayed:
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Create New S0L Site

Server details:

___“.\_

SQL Server: S0LSE

Timeout: 180

Server Administrator User Details

, @ Database User ) Wine
|
Administrator Username: |
Administrator Password: seae

Mew User For Mew Databases

@ Database User ) Wine
Mew User: Sellerl
Mew Password: seee

If you have already setup you default SQL server, the ‘Server Details’
and ‘Server Administrator User” will be populated. Leave these details
as they are, even if a different SQL server is required for this particular
site. The setup is the same as described here, but requires an extra step
which is detailed in the “Licensing a Site that uses a Specific SQL Server”
section on page 102.

If the SQL server is using ‘SQL Server Authentication” select ‘the
‘Database User’ radio button, then enter a ‘New User’” and ‘Password’ for
the database. This must be different to the username and password for
the Server Administrator. If the SQL server is using “Windows
Authentication’, select "'Windows User’. If you are not sure of the SQL
server settings, contact your SQL server administrator.

You can either accept the default names for the ‘Main Database Name’
and ‘Shipping Database Name’ fields or supply your own.

When done, click “OK” to begin the database creation process.

Once the databases have been created, your site will appear. You can
switch to it in the normal way by selecting it from the list and clicking
‘Activate’.

Note: if you wish to use a different SQL server to the default machine, do
not activate the site yet.
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If you need to change any of the server settings in the future, make sure
the site you wish to change is not active by activating another site within
‘File | Sites’, then single clicking the site you wish to change, then
clicking the “Configure’ button.

ODBC Details

Autharzation method

Windows Llser

@ Databaze Uszer

Usernarne; SellerDeckJzer
Pazsword: EESENEEREEEE
Server SOLSERVER2MWINSALZ | Look

Make the changes required, and then click ‘OK’".

Note: If you are experiencing timeouts when starting Sellerdeck
Enterprise or viewing a long list of orders, it is recommended you
increase the ‘Query Timeout’ value.

Licensing a Site that uses a Specific SQL Server

Sellerdeck Enterprise allows you to run different sites on different SQL
servers. The setup is the same as described in the “Licensing a Site that
uses a SQL Database using the Default SQL Server” section on page 100,
but requires one extra step which is described here:

Make sure the site is not active by selecting another site in the list and
choose “Activate’.

Highlight the site you wish to configure, and select ‘Database Setup’.

Select ‘Site Specific’ and provide the details for you ‘SQL Server” and
‘Server Administrator User Details. Click “'OK” when done.

The site can now be activated by selecting it in the list and choosing
‘Activate’.
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50QL Server Administration Details

Server details:
) Default @ Site Sp

Server details:

SOL Server: SQLSERV

Server Administrator User Details

@ Database User 1 Windo
Administrator Username: 53
Administrator Fassword: e i

Converting Existing Sites to SQL

If you have an existing sites that are running on an Access database, you
can convert them to SQL by selecting them within the ‘File | Sites’
window and clicking the ‘Convert” button. You can then set the server
details as described earlier in this section. Note that the site cannot be
active at the time so select another site within the list and click ‘Activate’.

Alternatively you can convert SQL sites to Access, by selecting the site
within ‘File | Sites” and selecting ‘Convert’.
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